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Keyboard

For information on the keystrokes available in each window (main or view), click on the 
appropriate entry below.

Main Window

View Window



Keyboard - Main Window

Switch between the directory list and the file list.

Switch between the directory list and file list.

You may press the first letter of a directory or file name to jump to the first name in the list 
(beyond the current position) with that name.

Also see: Selecting Files for more information on the keyboard interface for selecting files.

Menu accelerator keystrokes:

Edit - Auto Clip Save

Edit - Copy

Edit - Paste

Edit - Select All

Edit - Select Mask

Edit - Unselect All

File - Batch

File - Copy

File - Create Directory

File - Delete



File - Edit

File - Info

File - Information

File - Install Font

File - Label

File - Move

File - New Database

File - Open Database

File - Print Catalog

File - Print Setup - Catalog Setup

File - Print Setup - Page Setup

File - Print Setup - Printer Setup

File - Print

File - Remove Font

File - Rename



File - Slide Show

File - View

File - Wallpaper - Centered

File - Wallpaper - Remove

File - Wallpaper - Tiled

Help - Contents

Help - Search

Options - Confirmations

Options - File Loading - JPEG

Options - File Loading - PhotoCD

Options - File Loading - TrueType fonts

Options - File Loading - WordPerfect

Options - File Types

Options - General

Options - Monitor Gamma

Options - Save for Startup - Directory Path



Options - Save for Startup - Initial Database

Options - Save for Startup - Window Position

Options - Slide Show

Options - Status Line

Options - Toolbar

Options - Viewer

Thumbnail - Database Statistics

Thumbnail - Make All

Thumbnail - Make

Thumbnail - Refresh

Thumbnail - Remove Orphans

Thumbnail - Remove Tree

Thumbnail - Remove

Thumbnail - Scan Drive



Thumbnail - Scan Tree

Tree - Collapse all

Tree - Collapse to Path

Tree - Collapse

Tree - Expand All

Tree - Expand Branch

Tree - Expand One Level

Tree - Indicate Expandable

Tree - Indicate Thumbnails

Tree - Refresh Tree

Tree - Show Offline

Tree - Show Thumb Dirs Only

Window - Show All

Windows - Close All

 

Windows - Minimize All



Keyboard - View Window

Menu accelerator keystrokes:

Edit - Autocrop

Edit - Cancel Selection

Edit - Clone

Edit - Copy

Edit - Crop

Edit - Select All

Edit - Thumbnail From Selection

Edit - Undo

File - Close All

File - Page Setup

File - Printer Setup

File - Print

File - Reload

File - Save As

File - Save



Help - Menus

Help - Search

Image - Color Adjust

Image - Color Depth

Image - Convert to Bitmap

Image - Count Unique Colors

Image - Filter - Last Filter

Image - Filter - New Filter

Image - Filter - Select Filter

Image - Flip Horizontal

Image - Flip Vertical

Image - Histogram

Image - Invert

Image - Rotate/Resize

Image - Swap Red & Blue

Image - Turn ( 90)

Image - Turn (180)

Image - Turn (270)

View - Assumed Gamma

View - Autosize Window

View - Comments

View - Full Screen

View - Gridlines

View - Maintain Aspect Ratio



View - Options

View - Stretch to Fit Width

View - Stretch to Fit Window

View - Zoom In

View - Zoom Out



Introduction

ThumbsPlus is a graphic file previewer, locator and organizer which simplifies the process of 
finding and maintaining graphics, clip-art files, fonts and animations. It displays a small image 
(Thumbnail of each file. You can use ThumbsPlus to browse, view, edit, crop, launch external 
editors, and copy images to the clipboard. You can use drag-and-drop to organize graphics files 
by moving them to appropriate directories. ThumbsPlus will also create a slide show from 
selected graphics, and install bitmap files as Windows wallpaper.

You can print individual graphics files, or the thumbnails themselves as a catalog. ThumbsPlus 
can convert to several formats, either one at a time or in batch mode. You can also perform 
image editing in batch mode. ThumbsPlus will also convert metafile graphics to bitmaps 
(rasterize).

ThumbsPlus currently handles the following types of files. Types marked with an ® symbol are 
only available in the registered version only.

.AVI® Video for Windows animation file

.BMF Corel Gallery files (preview image only)

.BMP Windows Bitmap files (also recognizes .DIB and .RLE extensions)

.CDR CorelDraw V3/4 files (preview image only)

.CEL AutoDesk Animator Cel files (old and new formats)

.CGM Computer Graphics Metafile (binary encoding)

.EPS Encapsulated Postscript files (preview image only)

.GEM GEM Metafiles

.GIF CompuServe Graphics Interchange Format files

.ICO Windows Icon files

.IFF/LBM Amiga IFF format

.IMG GEM Image format

.JPG JPEG compressed files (in JFIF format)

.MND Mandelbrot for Windows image files (also handles .MNI)

.MOV® Apple QuickTimeTM for Windows

.PCD Kodak PhotoCD files

.PCX ZSoft Picture files

.PSD Adobe Photoshop files

.RAW Raw grayscale

.RAS Sun Raster format (also .SUN)

.TGA Targa TruevisionTM files (also .WIN)

.TTF TrueType fonts

.TIF Tagged Image Format files

.WMF Windows Metafiles and Placeable Metafiles



.WPG Word Perfect graphics (versions 1 & 2)

By using the Graphic Import Filters    supplied by Microsoft with Word for Windows, 
PowerPoint, MS Publisher and other packages, ThumbsPlus will also handle these (and more)
graphic file types:

.DRW Micrografx Designer and Draw

.DXF AutoCAD Interchange Format

.HGL HP Graphic Language

.PIC Lotus 1-2-3 Graphics files

.PLT AutoCAD Plot files

You can also use Object Linking and Embedding (OLE) to create thumbnails for and view any 
proprietary file type for which the server application is loaded on your system. Some types for 
which this has been tested are:

.BMF Corel Gallery

.CDR CorelDRAW! version 5

.DOC Word for Windows document

.DRW Micrographx Draw (using Designer 4.1 as the server)

.DS4 Micrographx Designer (using Designer 4.1)

.MGX Micrographx Designer

.PPT PowerPoint presentation



Directory Color Codes

If the option to Indicate Thumbnails is on from the Tree menu, each directory folder is colored to 
indicate the presence of thumbnails on the path.

There are no files in this directory with thumbnails, and no sub-directories have 
thumbnailed files either.

This directory contains no thumbnails, but one or more sub-directories do.

This directory contains thumbnails, but has no sub-directories with thumbnails.

This directory contains thumbnails, and has sub-directories with thumbnails.

This off-line directory has thumbnails.

This off-line directory has sub-directories with thumbnails, but none of its own.

This off-line directory has both thumbnails and sub-directories with thumbnails.



New Features (in 2.0 through 2.1, since 1.3d)

Additional internal file type handling:

· TIFF, Tagged Image Format.
· CGM, Computer Graphic Metafile
· EPS, Encapsulated Postscript (TIFF or Windows Metafile preview only)
· GEM, Atari and Ventura GEM Metafiles
· IMG, Atari or Ventura GEM images
· IFF/LBM, Amiga IFF and Deluxe Paint LBM
· PCD, Kodak PhotoCD files
· PSD, Adobe Photoshop (in 2.0c)
· BMF, Corel Gallery (preview only)
· RAS, Sun Raster format
· RAW, Raw Grayscale
· WAV, Windows sound files
· WPG, Word Perfect graphics (in 2.0c)
· CEL, AutoDesk Animator Cel files (in 2.0d)
· ®AVI, Video for Windows (in 2.1)
· ®MOV, QuickTimeTM for Windows (in 2.1)

®TWAIN Scanner Support (2.1)

ThumbsPlus can be used with any TWAIN-compliant scanner to scan images directly into the 
program for processing and storage.

Additional filter capability plus OLE:

ThumbsPlus can scan your disks searching for appropriate Aldus Rev. 1 filters, which you 
may have received with other packages. You can then assign these filters to file types that 
ThumbsPlus cannot handle internally.

Other file types can be handled via OLE if an appropriate server is available on your system.

Significant image editing capabilities, including:
Image Rotation and Resizing. Several improvements were implemented in version 2.0d.
Color Adjustment, including brightness, contrast, gamma correction, and hue.
Color Depth, including several optimized and fixed palette selections and several dithering 
methods. You can even paste a palette from an image on the clipboard to implement a 
common palette for several images. More palettes (including Indeo and Cinepak palettes) 
and additional optimization methods were added in 2.0d. Palette saving and loading from 
files was added in 2.0d also, along with support for generating identity palettes.
Miscellaneous functions, including Flip Horizontal, Flip Vertical, Invert and Swap Red & Blue.
You can now select from a stretched-to-fit window. (2.0c)
Quicker image turning, for rotation by 90, 180 or 270 degrees. (2.0d)
Save palettes and select palettes from .PAL files. (2.0d)
®Digital image filtering for raster images. Filters supplied include several blurring, 
sharpening, edge detection, despeckling and embossing filters. There is also support for 



user-defined linear and multi-pass filters. (2.1)

Several viewing enhancements, including:
On-the-fly gamma correction, with the ability to store a default assume gamma value for 
each image type, and a visually-calibrated monitor gamma value for each monitor mode. 
(Monitors may exhibit different color characteristics for different color depths and 
resolutions.)
On-the-fly quick dithering of 24-bit (truecolor) images on 8-bit displays. This gives you the 
ability to see a reasonable estimate of the image, though the quality is not nearly as good as
would be obtained on a 24-bit display.
Zoom-in to view portions of raster images in greater detail.
Zoom-in was implemented for metafile    and vector graphics in 2.0d.
There are now several selection cursors available for use in the view/edit window.

File conversion and saving capabilites, including:
Save images (bitmaps) as Windows bitmaps (.BMP), Compuserve GIF (.GIF), JPEG (.JPG),
Targa Truevision (.TGA), PC Paintbrush (.PCX) or Tagged Image File Format (.TIF).
Edit or add comments to GIF, JPEG and TIFF images.
Interactively preview the "lossiness" of specific JPEG quality levels before committing to one
(Truecolor or Highcolor display required).
Batch conversion of files to a specific type, with concurrent editing. You can edit (autocrop, 
rotate, resize, color adjust, color depth) and convert files in a single pass, and even include 
comments for the types which support them,

Automatic clipboard save provides the ability to automatically save clipboard contents to disk files.
ThumbsPlus saves each time the clipboard changes.

Selectable format (BMP, GIF, JPG, PCX, TGA).
Clipboard metafiles can be saved as .WMF or converted to a raster format.
Specify the desired path and file name prefix.
Useful for screen or window capture, too (using PrintScreen and ALT+PrintScreen).

File list improvements (2.0c) (see the File List selectionfrom the Options menu), including:
Sort by name, extension, date or size
Show date and/or size along with the file name
Show files that match a mask (i.e., A*.GIF)
Show font names in the list, rather than file names
Indication that fonts are installed (by showing the name in green)
Ability to show hidden and system files

Slide show improvements (2.0c):
ESC will abort loading an image during the slide show
Show slides in random order
Show file names at bottom of window

Miscellaneous other enhancements:
Install and remove TrueType fonts: singly, selected groups, or entire directories full.



Label diskettes from within ThumbsPlus.
Several performance enhancements, including less repainting of the directory and file lists, 
faster scaling of bi-level (monochrome) bitmaps, and quicker program startup.
ThumbsPlus can now be associated with any viewable file type -- pick "ThumbsPlus Picture"
as the association in the File Manager "Associate" dialog box.
Automatic saving of profile (INI) options for each dialog box, rather than Set/Use defaults as 
before. (2.0c)
You can now specify the title line for a printed Catalog. (2.0c)
A Wallpaper - Remove option has been added, (2.0c)
Automatic or manual "orphaned" thumbnail removal (gets rid of thumbnails for files that have
been moved or deleted externally). (2.0c)
CMYK TIFF files are now supported. (2.0c)
The status bar has been updated to reflect when directories and files are being read. (2.0c)
You can now abort long image loads by pressing ESCape. (2.0c)
You can export thumbnails as Windows bitmap files (with a .TNB extension) for use in other 
applications.
TrueType fonts (.TTF) can now be viewed. ThumbsPlus displays a window with the 
character set and sample text. There's also a TrueType Loading setup dialog box. (2.0d)
Converting metafiles to bitmaps (rasterizing) now asks for the desired size of the resluting 
bitmap, rather than using the current window size. (2.0d)
A Help button has been added to each dialog box. You may also use the F1 key to obtain 
help for a specific dialog box.
Progress indicate during image functions is now shown in a small status strip at the bottom 
of the window. (2.0d)
Thumbnails may now be scaled to as much as 2000% for catalog printing. (2.0d)

Bugs fixed in 2.0d (since 2.0c)
Saving TIFF files no longer causes a General Protection fault.
Problems fixed matching TrueType font names.
Autocrop now works correctly with 24-bit images.
Improved highlighted directory list entry.
New and Open Database commands were moved to the File menu for CUA compatibility.
Removing orphans no longer removes all thumbnails.
Several missing accelerator keystrokes and menu help items were added.
Printing now works from the View window.
A slide show color problem (on some 256-color displays) was fixed.
Several problems with improperly rounding or showing image resolution (DPI) were 
corrected.
Several other small corrections.



Main Window

The main window consists of the normal Windows interface (title bar, menus, etc.) and three 
functional areas, as shown below:

 Click on the picture above (anywhere the cursor becomes a hand) to find out about the 
various parts of the display.
Additional information:
The toolbar provides short-cuts to several frequently-used commands.
The directory list displays disks and directories from which you may select a directory to 
display. Unless disabled from the Tree menu, directories are color-coded to indicate the 
presence of previously "nailed" images:

Selecting a directory works much like the Windows File Manager; most operations and menu 
short-cuts work similarly, and you can drag-and-drop selected files to move or copy them to 
different directories and drives.

When you select a directory from the directory list, file names (and thumbnails, if generated), 
display in the file list.

You may select one or more files from the file list, then take action on the selected image(s) 
from the toolbar or menus.

You may also drag the selected files to a new directory or disk.



Selected File

The captions (file names) of selected files are highlighted. Some toolbar and menu options will 
be grayed if no files are selected.



Scrollbar

A scrollbar allows you to select the part of a list of items you want to display, when all of the 
items will not display in the area. For vertical scroll bars, click on the left and right arrows to 
move a column at a time; for horizontal scroll bars, click on the up and down arrows to move a 
line at a time.

You can drag the box to move proportionally within the scrolled data; you can click on either side
of the box to move a full window of information at a time.



Selected Directory

The currently selected directory in the directory list is highlighted. This is the directory that 
contains the files in the file list.



Disk and Volume Icons

All disk drive in your system and all removable disks (floppies and CDROMs) that you have 
scanned for thumbnails are represented by small icons in the directory list.

Removable diskette, such as 3.5" and 5.25" floppies.

A local, fixed hard drive.

A network (remotely mounted) drive.

A CDROM drive.

A memory (RAM) disk, used only for temporary storage.

An offline volume which has been scanned for thumbnails. You can view the thumbnails 
for these volumes without having to insert them in a drive.



Disk Labels

Every disk or diskette used in DOS and Windows can have a volume label. If you want to keep 
track of files on multiple disks, it will be much less confusing (to you and to ThumbsPlus) if each 
disk is labeled uniquely.



Vertical Split Bar

The cursor will change when over this area. You can press the left mouse button and drag the 
split bar to the desired position, so the directory and file lists are the sizes you want.



Maximize

This button maximizes ThumbsPlus (resizes it to fill the screen). You can click this button again 
to restore ThumbsPlus to its previous size.



Minimize

This button minimizes ThumbsPlus (reduces it to an icon). You can double-click the icon to 
restore ThumbsPlus.



Title Bar

This caption shows the current program (ThumbsPlus in this case), along with the file it has 
open.



System Menu

Selecting this button brings down the standard Windows system menu, from which you can 
move, size, restore, minimize, maximize, or close ThumbsPlus. You can also bring up the Task 
List (with the Switch To option) to switch to another application in Windows.



Status Line

The status line shows information about the currently selected drive, directory and files. It also 
shows the number of files in the directory.

When dragging to a directory, the text in the status line will turn red if there is insufficient space 
to copy the selected files.

When selecting from a menu or passing the mouse over toolbar buttons, a description of the 
action appears on the status line.

The status line may be turned on or off using the Options - Status Line menu selection.



Toolbar

 Click on any button below to see a description of its action.



ThumbsPlus Menus

 Click below on the menu of interest.



File - View Enter

Opens a view window for each of the currently selected files, up to the maximum specified in the
General Options dialog box. This option will be grayed if no files are selected.

From the General Options dialog box, you can selecting Viewing as the default (double-click) 
action for files.



File - Edit Shift+Enter

Edits the first selected file by launching the editor defined for its file type.

From the General Options dialog box, you can selecting Editing as the default (double-click) 
action for files.



File - Info F6

This option displays an information window for each selected file in turn. Press Next to continue 
to the next selected file or Cancel to stop.



File - Delete Delete

Deletes the selected file(s). If confirmation of file deletion is selected from the Confirmations 
dialog box, you will be prompted whether or not to delete each file.



File - Wallpaper - Center F7

This option installs the first selected file in the file list as the Windows wallpaper on the desktop. 
If the file is not a Windows bitmap file, or if it is not on a local hard drive, it is converted to a 
bitmap and copied to a temporary file, which is installed.

This option centers the bitmap on the screen, and is recommended for large images.



File - Wallpaper - Tile Shift+F7

This option installs the first selected file in the file list as the Windows wallpaper on the desktop. 
If the file is not a Windows bitmap file, or if it is not on a local hard drive, it is converted to a 
bitmap and copied to a temporary file, which is installed.

This option tiles the screen with the bitmap, and is recommended for small images.



File - Wallpaper - Remove Ctrl+F7

This options removes the Windows desktop wallpaper.



File - Slide Show F8

Displays the selected images one at a time, in full-screen mode, with a delay between images. 
Press any key or the left mouse button to end the slide show. You can configure the slide show 
by selecting Options - Slide Show.



File - Copy F5

Prompts for the desired directory to copy the selected files to, and copies them there. 
Alternately, you can drag the selected files to the intended directory. To force copying (rather 
than moving, which is the default when dragging files to a directory on the same disk), you can 
hold down the CTRL key while dragging.



File - Install Fonts Shift+F6

This option is available if the first file selected is a TrueType font. It installs any selected fonts 
that are not already installed, and updates the WIN.INI file so they will be available the next time
Windows starts.



File - Remove Fonts Ctrl+F6

Any selected TrueType fonts that are currently installed will be removed, and removed from the 
WIN.INI file. Be sure the first selected file is a TrueType font so that this selection will be 
available.



File - Label Disk Ctrl+L

Use this selection to create a volume label for a diskette. ThumbsPlus cannot keep track of 
which diskette contains which files unless they are labeled.



Batch Convert/Edit - Miscellaneous Batch Operations

This dialog box allows you to select various image operations that you can do from the View 
window menus.

Metafile Rasterization. These items are used when a metafile or vector graphic is converted to 
a bitmap. They are the same items requested from the Image - Convert to bitmap menu option.

Width - The width of the bitmap to create from the metafile. 

Height - The height of the bitmap to create from the metafile.

Maintain Aspect Ratio - Force the bitmap to be the same aspect ratio as the original 
metafile.

Autocrop. All same-colored borders from the image are removed. This option works only for 
bitmap (raster) images with solid borders. The lower-left corner pixel is used as a reference 
pixel -- all contiguous border of this color is cropped from the image. This function is done 
individually from the Edit - Autocrop menu selection in a view window.

Invert. Replaces each pixel in the image with its inverse -- black becomes white, red becomes 
green, etc. (See Image - Invert.)

Swap Red & Blue. Swaps the red and blue value of each pixel. This is required for some file 
types for which the RGB order is ambiguous or incorrectly reported in the file header. (See 
Image - Swap Red & Blue.)

Flip Horizontally. Replaces the image with a mirror image (left-to-right). (See Image - Flip 
Horizontal.)

Flip Vertically. Replaces the image with a mirror image (top-to-bottom). (See Image - Flip 
Vertical.)



Equalize Histogram®. Computes an intensity histogram and equalizes (as much as possible) 
the intensity levels in the image. This improves the appearance of some images, but may give 
others too much contrast. See Image - Histogram for more information.



File - Batch Convert/Edit Ctrl+Enter

With ThumbsPlus, you can convert and edit (in a single pass) many files in the background 
while you continue to work on other things (even start another copy of ThumbsPlus) This option 
displays a dialog box, which you use to control the batch process. Once you've made the 
selections and press the OK button, ThumbsPlus will prompt you for any options for the specific 
output format you've chosen, including comment fields and compression options.

You must select the files you wish to process before selecting this option. See Selecting Files for
more information on how to select specific files. Each option in the dialog box is discussed 
below.

Output Format

Select the output format for the files. ThumbsPlus will save each file in this format. If you select 
a metafile format, such as WMF, then the image editing options will be disabled, and only 
metafiles will be processed. If you select the WMF (encapsulated bitmap) format, ThumbsPlus 
will generate a metafile containing the bitmap -- it will not trace the bitmap to obtain a vector 
representation.

Alternate Extension

If you want the output files to have an extension different from the one selected in the Output 
Format, the enter it here.

Filter®



Check this box to enable digital image filtering of each image. Click on the button to use the 
Filter dialog box to select and configure the filter to use. ThumbsPlus displays a description of 
the filter to the right of the button.

Misc.

Brings up the Miscellaneous Batch Operations dialog box, which allows you to select the size 
for converting metafiles to bitmaps, and various miscellaneous functions such as autocrop, flip, 
and histogram equalization.

Resize

Check this box to enable rotation and/or resizing of each image. Click on the button to use the 
Rotate/Resize dialog box to set the options. ThumbsPlus displays a description of the action to 
be taken on the right of this button. If you rotate and resize, you may want to select an output 
Color Depth (below), as files are promoted to either 24-bit (truecolor) or 8-bit grayscale for 
proper rotation and resizing.

Color

Check this box to enable color adjustment of each image. Click on the button to use the Color 
Adjustment dialog box to set the amount of brightness, contrast, gamma and hue adjustment to 
apply to each image.

Color Depth

Use this selection to specify the output color depth, just as you would for an individual image. 
The Color Depth dialog box will allow you to specify the number of colors you desire, the palette
you want to apply (even one pasted from the clipboard!), and the type of dithering.

Output Path

Specify here the disk and directory you wish to send the converted and edited files to. You can 
use the Browse button to locate a directory you want to use.The files will be named the same 
as the input, except that the appropriate extension (default, such as BMP, JPG, or TGA, or 
specifically set in the Alternate Extension) will be used.

Overwrite Existing Files

Check this box if you want ThumbsPlus to overwrite files of the same name. If this box is not 
checked, and ThumbsPlus encounters an output file already there, it will skip that input file and 
display a message in the "Errors Encountered" area in the progress dialog box.



File - Move Shift+F5

Prompts for the desired directory to move the selected files to, and moves them there. If the 
directory is on another disk, this will copy each file, then delete the original. Alternately, you can 
drag    the selected files to the intended directory. To force moving (rather than copying, which is 
the default when dragging files to a different disk), you can hold down the SHIFT key while 
dragging.



File - Rename Ctrl+Shift+F5

Prompts for a new file name for each selected file, and renames it accordingly. You cannot 
move a file to a different directory with this option; use File - Move instead.



File - Create Directory Ctrl+F5

Prompts for a directory name to create as a sub-directory for the current directory (selected in 
the Directory List).

Note that since it has no thumbnailed files int it, this new directory will not be visible in the 
directory list unless Tree - List Thumb Dirs Only is not checked.



File - Print Catalog Shift+F9

Prints a catalog of the thumbnails in the database, organized by directory. If you choose to print 
only the selection, then ThumbsPlus will print thumbnails for the selected directory in the 
Directory List, and all its sub-directories. If you choose to print All, then ThumbsPlus will print all 
thumbnails in the current database.

Note: ThumbsPlus does not re-examine the directories on disk during the printing operation, so 
thumbnails will print for files which were thumbnailed, but deleted from outside of ThumbsPlus. 
You can use the Remove Orphans to get rid of these before printing a catalog.

The format of the catalog is extensively customizable by the Catalog Setup dialog box.



File - Catalog Setup Ctrl+Shift+F9

This dialog box allows you to customize the printing of thumbnail catalogs.

Thumbnail Size

You can vary the printed size of the catalog from 50% to 500% of the size of the thumbnail in 
the database (96x72 pixels), thus cramming more or fewer thumbnails onto a page. Higher 
percentages provide more opportunity for monochrome printers to dither, but may look "chunky" 
because of the stretching of the bitmap.

Columns

You can vary the number of columns to print; however, the maximum number is based on the 
Thumbnail Size and the resolution and page size of your printer.

Line Spacing

Allows you to specify the amount of space between lines of thumbnails in the catalog.

Margins

Allows you to set the top, left, right and bottom margins (in inches).



Font

You can select the font to print the headings and the file names.

New page for each directory

When selected, ThumbsPlus will start a new page for each directory.

Print file names

Select this checkbox to cause ThumbsPlus to print the file name for each file under its 
thumbnail. Unselect it to cram more thumbnails onto a page.

Preview Window

This window shows a miniature layout of the page, per the options you have selected.



File - TWAIN Select Source®

Use this option to activate the TWAIN Data Source Manager (DSM), from which you may select 
the desired TWAIN source (generally a scanner, camera or other input device).



File - TWAIN Acquire®

This selection will acquire one or more images from the currently selected TWAIN data source. 
You must have TWAIN software from your scanner, camera, or other TWAIN data source vendor
to use this option.

You will most likely receive a dialog box that lets you preview, crop and set-up the scanner.

ThumbsPlus does not provide support for any scanners which are not TWAIN compliant.

ThumbsPlus will not currently load images larger than about 16Mb (though the amount of 
memory on your machine may limit this further).

If you have multiple TWAIN sources, you can use File - TWAIN Select Source to select the 
particular source you wish to use.



File - Print F9

This selection prints all selected graphics files. Each prints on a separate page, with no textual 
information. You can set the margins and other options using the Page Setup dialog box. To 
print a catalog of thumbnails, use the Print Catalog menu option.



File - Page Setup Ctrl+F9

This dialog box allows you to customize the printing of individual graphics files.

Margins

Set the top, left, right and bottom margins on the page (in inches).

Stretch image to fit page

Will cause ThumbsPlus to stretch the images to fill the printed page (within the margins).

Maintain aspect ratio

When selected, ThumbsPlus will ensure the the width and height maintain the ratio in the 
original image, to avoid distortion.

Print Borders

Causes ThumbsPlus to draw a simple black rectangle around the edge of the image.



File - Printer Setup Ctrl+F8

This selection displays the Printer Setup dialogbox, which allows you to select an alternate 
printer and set printing options.



File - Exit Alt+F4

Select this option to exit ThumbsPlus



 

 Click on any selection above.



Edit - Copy Ctrl+C

This option copies the first selected file to the clipboard in the appropriate format for the file 
(bitmap for raster images or metafilefor vector images).

If no files are selected, this menu option is grayed.

You can make this option the default (double-click) option from the General Options dialog box.



Edit - Paste Ctrl+V

This option pastes the current clipboard contents to a ThumbsPlus View Window. If the 
clipboard is empty, or the contents are not in a recognized graphics format, this options is 
grayed.



Edit - Clear All Ctrl+A

This option deselects all selected files in the file list.



Edit - Select All Ctrl+Shift+A

This option selects all files in the file list for processing by any of the commands which accept 
multiple files, such as view, info or slide show.



Edit - Select Mask Ctrl+Shift+M

This option prompts for a filename mask (i.e., "A*.GIF") and selects all files matching the mask. 
Any previous selection(s) are cleared.



Edit - Auto Clip Save Ctrl+Shift+C

This selection allows you to automaticly save the clipboard contents to a disk file each time they
change (and a compatible format -- bitmap or metafile -- is on the clipboard).

This is very useful for window or screen capture, too -- turn it on, and each time you press 
PrintScreen (for the entire screen) or ALT+PrintScreen (for the current window), ThumbsPlus 
will save the screen or window as a graphic file.

Enable

When checked, automatic clipboard saving is enabled. The Auto Clip Save menu selection is 
also checked when enabled.

Convert Metafiles

When checked, metafiles on the clipboard will be rasterized and saved; otherwise, they will be 
saved as Windows metafiles (.WMF).

Image File save format

Select the desired file type to save.

Output Path

Select the directory where you want the auto-saved files to be stored. The Browse button 
allows you to find a directory easily.

Prefix

Enter a prefix for the file name. Use less than 8 characters; whatever is left will be filled in with a
sequence number. For example, if you enter SCRN here, and select BMP as the type, the files 
will be saved as SCRN0000.BMP, SCRN0001.BMP, etc.

Seq. #

This is the next sequence number to use in the generated file names.





 Click on any selection above.



Tree - Expand Branch Keypad *

This option expands the currently selected directory entry in the Directory List by showing any 
sub-directories. Any sub-directories are also expanded, thereby showing this "branch" of the 
tree in its entirety.

If Indicate Expandable is checked, the folders for directories which have sub-directories are 
marked with a '+'.

If Indicate Thumbnails is checked, directories are color-coded to indicate the presence of 
thumbnails.



Tree - Expand One Level Keypad +

This option expands the currently selected directory entry in the Directory List by showing any 
sub-directories. Double-clicking an expandable entry also performs this action.

If Indicate Expandable is checked, the folders for directories which have sub-directories are 
marked with a '+'.

If Indicate Thumbnails is checked, directories are color-coded to indicate the presence of 
thumbnails.



Tree - Expand All Ctrl + Keypad *

This option expands all branches of all drives and off-line volumes in the directory tree.



Tree - Collapse Branch Keypad -

This option hides any subdirectories of the currently selected entry. Double-clicking on an 
expanded entry also does this.

If Indicate Expandable is checked, the folders for directories which can be collapsed are marked
with a '-'.



Tree - Collapse All Ctrl + Keypad -

Hides all directories, leaving only the top level (drive and off-line volume) entries.



Tree - Collapse to Path Keypad /

This option collapses all entries except those directories on the currently-selected path. For 
example, if the current directory is C:\WINDOWS\SYSTEM, all entries for drives other than C 
are hidden, all first-level directories of C: are shown, and all sub-directories of WINDOWS are 
shown.



Tree - Refresh Tree Ctrl + Keypad +

This option rereads the directory tree. Use this option if you change the directory structure from 
another application. This option also collapses the tree to the current path (Tree - Collapse to 
Path).



Tree - Show Offline Volumes Ctrl+Shift+F

Select this option to display disks which have been scanned but are not currently on an inserted
disk. This will display each such volume as a small diskette, with the disk label next to it. For this
option to operate properly, it is important that each diskette have a unique label. This options 
works for CDROMs as well as diskettes.

This option will also allow you to view directories and files which have thumbnails, but have 
been removed from the disk by a program other than ThumbsPlus. The folders for these 
directories, and the names for these files, will be grayed. If you do not intend to restore these 
files to the disk, you can use Thumbnail - Remove or Thumbnail - Remove Tree to remove the 
thumbnails from the database.



Tree - Indicate Expandable Ctrl+Shift+X

Checking this menu item causes ThumbsPlus to display a '+' in directory entries which contain 
sub-directories and may be expanded, or '-' in directory entires which are already expanded.



Tree - Indicate Thumbnails Ctrl+Shift+I

Checking this option causes ThumbsPlus to use differently colored folders to indicate 
"interesting" directories. Folders for directories which contain thumbnails are colored green; 
folders for directories which do not themselves have thumbnails, but whose subordinate 
directories do, are colored blue. This option is really useful only after drive(s) have been 
scanned for images (see Scan Drive).



Tree - List Thumb Dirs Only Ctrl+Shift+O

Select this option to only show directories which contain thumbnails. This is only useful once 
graphics files have been located (usually by Scan Drive).



 Click on any selection above.



Thumbnails - Make F2

This option does the hard work of ThumbsPlus: it reads the graphic files selected in the Image 
List and reduces them to create thumbnails, and stores the thumbnails in the ThumbsPlus 
database. These minature pictures of your graphics files make life with Windows easier by 
helping you find specific images or drawings quickly and easily.

To create or update thumbnails for all files in the current directory, use the menu option 
Thumbnails - Make All. To scan a disk drive for all recognized files, use Thumbnails - Scan 
Drive.

Unlike these other options, Thumbnail - Make does not check for updated files and always 
makes thumbnails, regardless of whether one is already on file.



Thumbnails - Make All Shift+F2

This option creates or updates thumbnails for all recognized files in the current directory. If a 
thumbnail already exists for a file, its update date and time are checked against what is stored in
the ThumbsPlus database. If the file has been modified since the thumbnail was made, it is 
regenerated from the file.

While running, a progress box displays which indicates how much of the work is complete. Click
Cancel to quit making thumbnails. This progress box also contains a list box where any errors 
which occur are listed. These errors include the file name being "nailed" at the time of the error. 
If any errors occur, the progress box will remain until you click OK.



Thumbnails - Statistics Ctrl+T

This option provides disk usage information about the ThumbsPlus database. You may also 
Purge the database from this dialog box, which rewrites the ThumbsPlus file excluding any 
deleted thumbnails.

Images In File The total number of thumbnails which are stored in the ThumbsPlus 
database, not including deleted thumbnails.

Space in Use The number of bytes of disk space used by the thumbnails, not 
including the index.

Deleted Space The amount of disk space in use by thumbnails which have been 
deleted. Whenever a thumbnail is replaced, the original thumbnail's 
space becomes deleted space. The Purge button will reclaim this 
deleted space, making it available for new thumbnails or other 
applications.

Average Compression ThumbsPlus compresses the thumbnails using a simple Run Length 
Encoded algorithm. This number indicates the amount of space 
saved by this algorithm. A standard bitmap of a thumbnail would take
6912 (96 * 72) bytes; ThumbsPlus saves much of this space 
(generally 50-85%).



Thumbnails - Remove Tree Shift+Ctrl+Del

This option removes all thumbnails for the current directory tree selected in the Directory List. 
The corresponding files are not deleted.



Thumbnails - Remove Shift+Del

This menu selection removes all thumbnails that are selected. This option does not delete the 
corresponding files.



Thumbnails - Remove Orphans Ctrl+Del

This selection will remove any "orphaned" thumbnails (those for files that have been deleted 
from another program) in the current directory tree or the current drive.

The Reclaim Disk Space After Processing option causes a Purge of the database after the 
orphans are removed. This reclaims the disk space that was used by the orphaned thumbnails. 
You may also purge the database by clicking on the Purge button in the Database Statistics 
dialog box.

Orphaned thumbnails may also be removed automatically whenever you change to a directory 
by checked "Automatically remove orphans" in the General Options dialog box.

Some users prefer that orphans remain for removed files, especially those that have been 
archived.



File - New Database Ctrl+N

Use this option to create a new thumbnail database. For more discussion on ThumbsPlus 
databases, see the File - Open Database command.



File - Open Database Ctrl+O

If you have a lot of graphics files, you may want to organize them into separate databases. This 
option allows you to select another database to open.

ThumbsPlus databases should have the extension ".TUD". Each of these databases has an 
associated index file, with the extension ".TUX".

ThumbsPlus can only one a single database at a time, though you can run ThumbsPlus multiple
times, each time with a different database.

You can specify the database for ThumbsPlus to use on the command line, from Program 
Manager. You can also double-click on .TUD files from File Manager to bring up ThumbsPlus 
with a specific database.

To create a new database, use the File - New Database menu option.



Thumbnails - Refresh File List F3

This option re-reads the current directory and searches for thumbnails for any files there. You 
should select this option if you delete, move or add to the files in the current directory.



Thumbnails - Scan Drive Ctrl+F2

When you select Scan Drive, ThumbsPlus examines all files on the current drive looking for 
files that it recognizes and creates a thumbnail for each of them. If a thumbnail already exists for
a file, its update date and time are checked against what is stored in the ThumbsPlus database. 
If the file has been modified since the thumbnail was made, it is regenerated from the file.

While running, a progress box displays which indicates how much of the work is complete. This 
progress indicator is based on the total space in use on the drive, and is updated by the size of 
each file as it is examined. Since graphics files are usually grouped together, and different types
of files take various amounts of time to analyze and reduce, this indicator does not really 
indicate the amount of progress made in time, but only how far through the disk ThumbsPlus 
has looked.

Click Cancel in the progess box to quit making thumbnails. This progress box also contains a 
list box where any errors which occur are listed. These errors include the file name being 
"nailed" at the time of the error. If any errors occur, the progress box will remain until you click 
OK.

Note that most CD-ROM disks have useless "total size" information stored on them, so the 
progress percentage is essentially meaningless for these drives. 



Thumbnails - Export Selected

This option creates bitmap files of all currently selected thumbnails. The files are 96 x 72 pixels, 
8-bit color (236 colors used), and stored in Windows Bitmap (BMP) format with a .TNB 
extension and the same name as the original file.

The files created with this option may be renamed or converted to other types. You can set up 
the ".TNB" file type in the File Types dialog box as equivalent to BMP files so they may be 
viewed, renamed or converted in ThumbsPlus.



Thumbnails - Scan Tree Shift+Ctrl+F2

When you select Scan Tree, ThumbsPlus examines all files in the current directory and any of 
its sub-directories.

While running, a progress box displays which indicates how much of the work is complete. This 
progress indicator is based on the total space in use on the drive, and is updated by the size of 
each file as it is examined. Since graphics files are usually grouped together, and different types
of files take various amounts of time to analyze and reduce, this indicator does not really 
indicate the amount of progress made in time, but only how far through the disk ThumbsPlus 
has looked.

Click Cancel in the progess box to quit making thumbnails. This progress box also contains a 
list box where any errors which occur are listed. These errors include the file name being 
"nailed" at the time of the error. If any errors occur, the progress box will remain until you click 
OK.



 Click on any selection above.



Options - Save for Startup - Window Position Ctrl+Shift+P

This option saves ThumbsPlus's current window position and size. Subsequent runs of 
ThumbsPlus will place the main window at its current position. Note that this is set for the 
current database only, so that you can configure different datbases to start at different window 
positisions.



Options - Save for Startup - Initial Database Ctrl+Shift+E

This option sets the current database as the default database for ThumbsPlus. Unless another 
database is specified on the ThumbsPlus command line (File - Properties in Program Manager),
ThumbsPlus will open this database.



Options - Save for Startup - Directory Path Ctrl+Shift+D

This option saves the current directory as the startup directory for the current database; 
whenever you open this database, ThumbsPlus will position to the current directory. This helps, 
for example, if you have a "Fonts" database, and a directory containing fonts. You can set the 
startup directory for the Fonts database to the Fonts directory, so that you don't have to click 
around in the directory list to find the fonts.



Options - File Loading - JPEG Ctrl+J

This dialog box sets the options for loading JPEG files.

The JPEG library allows you to select how to load JPEG files. JPEG files are always stored as 
24-bit (truecolor) images, but the library can automatically dither them to 8-bits for displaying on 
256-color devices. This dithering will interfere with editing, however: if you want to edit JPEG 
files on an 8-bit display, it is best to load them as Truecolor even though they don't look as nice. 
In other words, on an 8-bit (256 color) display, JPEGs are best loaded for viewing as 8-bit 
color, but best loaded for conversion or editing as 24-bit (Truecolor). For quick viewing on 8-bit
displays, load them as Grayscale.

The Two-Pass Quantization and Dither options apply only if loading as 8-bit color; deselecting 
either or both will speed the load and conversion to 8-bit, at a sacrifice in appearance. The 
JPEG load dithering is similar to the Floyd-Steinberg dithering available as an option in the 
Color Depth dialog box.

The Full, 1/2, 1/4 and 1/8 size options allow you to load a JPEG file at smaller than its actual 
dimensions. This speeds up loading considerably, and allows you to load files that are too large 
for your system's memory configuration.



Options - File Loading - WordPerfect Ctrl+P

Use this dialog box to set options for rendering WordPerfect graphic (WPG) files.

Ignore Shadows. If this box is checked, ThumbsPlus will not render object shadows in WPG 
files. This may speeed processing, and may make files easier to edit in other (non-WP) 
applications.

Ignore Gradient fills. If this box is checked, ThumbsPlus will not render gradient fills. This will 
greatly speed processing and reduce the size of resultant metafiles (either copied to the 
clipboard or saved to disk).

Ignore Text objects. Check this box if you dont want text information in WPG files rendered.

Use TrueType fonts only. Check this box to force ThumbsPlus to select a TrueType font for 
any text in WPG files. This option is meaningless if Ignore Text Objects is checked.



Options - File Loading - TrueType Fonts Ctrl+U

Use this dialog box to control the actions taken when ThumbsPlus thumbnails and views 
TrueType fonts.

Thumbnail Sample Text. This text is used to create the thumbnail for the font. By default, this is
blank and the font name alone is used to create the thumbnail.

Include Font Name. Checking this box causes ThumbsPlus to use both the sample text above 
and the name of the font for the thumbnail.

Window Sample Text. This text is displayed at the bottom of the font view window to show an 
example of how the text looks with several characters together.



Options - File Loading - PhotoCD Ctrl+H

This dialog box selects the options for loading PhotoCD images.

The Size to load section allows you to select the desired size of the loaded image. Note that 
the horizontal and vertical sizes will be reversed for images stored in portrait orientation.

The Color format section allows you to select the color resolution of the loaded image.



Options - Monitor Gamma Ctrl+M

This option allows you to calibrate the gamma correction value for your monitor. A gamma value 
of 0.0 means that ThumbsPlus will not gamma correct any image.

Simply adjust the scroll bar, using either the arrows at the ends or by dragging the central box, 
until the central gray square is as close as possible to the color of the surrounding pattern. For 
best results, calibrate in a darkened room.

As some monitors exhibit different characteristics at different display resolutions and color 
depths, ThumbsPlus will save a different gamma value for each combination.

Some image types have a specific gamma value for which they are corrected (for example, GIF 
files are corrected for a monitor gamma of 2.0). If you choose to use gamma correction, you 
need to set each type appropriately, from the Assumed Gamma dialog box. Unless this value is 
set for a specific file type, it will not be adjusted.



Options - Status Line Ctrl+Shift+L

This menu option toggles the status line on or off.



Options - Toolbar Ctrl+Shift+B

This menu option toggles the toolbar on or off.



Options - File Types Ctrl+F

New. Runs the File Type Configuration dialog box so you can define a new file type for 
ThumbsPlus to handle.

Configure. Runs the File Type Configuration dialog box to change the configuration of a 
specific file type.

Select All. Select this option to show all configured file types in ThumbsPlus. Files that are not 
recognized will not have thumbnails, but you can move, copy, delete and rename these files.

Clear All. Select this option clear all selected file types, so you can start selecting from scratch.



File Type Configuration

This dialog box, which is accessed from the Options - File Types dialog box using the New or 
Configure button, allows you to define a new file type for ThumbsPlus to support, or to modify 
the configuration of a specific type.

ThumbsPlus can recognize any file type it supports internally, regardless of its specific name or 
extension. However, for files accessed through external filters or OLE, the extension may be 
important.

Extension. Enter the one, two or three character extension (without the period) for the file type 
to define.

Description. Enter a description of the file type. If the file type is equivalent to another (see 
below) you can leave the description blank --ThumbsPlus will automatically use the description 
of the base file type.

Equivalent to type. If the file type is equivalent to a type already known to ThumbsPlus, select 
that type here. This will disable most of the other entries in the dialog box, since the access to 
the type is defined through its base type.

Class. Select the type of file. For most purposes, Vector and Raster are appropriate. Several of 
the types give more information about the type of file and may be useful for categorizing OLE-
based files. OLE-based types not classed as Raster are loaded as Vector.

Load file using. Select the method that ThumbsPlus should use to load the file:
Internal - ThumbsPlus should use its internal loading routines to load the file. The file must 

be recognizable by ThumbsPlus.
Filter - Use a Aldus Rev. 1 filter to load the file. The next field (>>) should be used to select 

the filter; if the list is blank, use    the Hunt for filters button to search for filters on your 



system.
OLE - ThumbsPlus should attempt to attach to an OLE server for the file type to render it as 

a metafile or bitmap. Select the appropriate server from the next (>>) field.
None - ThumbsPlus should not attempt to load the file. It can still be shown in the file list, 

with an appropriate icon, if Edit Using is set to Association.

Edit file using. Select the method that ThumbsPlus should use to edit the file. Note that raster 
images may be edited to some degree from within a ThumbsPlus view window.

Association - Use the Windows File Manager association, as registered by FIle Manager, to
launch the program to edit the file. If you don't select a specific item from the next list 
(>>), ThumbsPlus will use the file extension to attempt to locate an association.

Command - Enter a specific command to edit the file. You can use '%F' in the string as a 
token to be replaced by the file name.

None - Don't attempt to launch an editor for this file type.

Print file using. Select a method for printing the file type If it is loadable into ThumbsPlus, the 
Internal method usually works best. Otherwise, you may select Command or Association, as 
described under Edit File Using.

Hunt for filters. This button brings up a dialog box from which you can scan your disk drives 
searching for Aldus Rev 1 graphic filters to be used for loading graphics files. Note that Accusoft
filters (which usually end in 9, as in IMWPG9.FLT) will be found, but will not work properly.



Options - File List Ctrl+E

This option displays a dialog box from which you can control the display of the file list and 
thumbnails in ThumbsPlus.

Order By. Selects the order in which files are displayed in the file list. You can sort by name, 
extension, size or date.

Show for Each File. Select the items you wish to view for each file.

Include Hidden Files. Causes ThumbsPlus to display system and hidden files in addition to 
normal files.

Show Font Names. When this is selected, ThumbsPlus will scan TrueType font files and load 
the font names. It will display these instead of the file names. Additionally, the font names will be
green if the font is installed.

Name Mask. Check this box and enter a mask to select files based on a mask rather than on 
the types selected in the File Type dialog box.

Thumbnail Size. ThumbsPlus can enlarge the thumbnails on the fly. This is especially useful for
very high resolution displays (1240x1024 and higher). Select the desired thumbnail size here. 
The stretching operation makes the file list display slightly slower.



Options - General Ctrl+O

This option displays a dialog box which allows you to set the parameters for the operation of 
ThumbsPlus

Automatically Crop Images. Automatically crops, by removing all continuous border of the 
same color, any image. This may be on or off for each of the following operations:

On copy to clipboard
When making thumbnails
When viewing

Default Action. Selects the default action (taken for a double-click with the left mouse button). 
Select one of the following operations:

View Image
Copy to Clipboard
Edit Image

Font. Shows the currently selected font for the Image List and the Directory List in the main 
window. Click on Select Font to change this font.

Minimize ThumbsPlus Window. Selects times when you would like the ThumbsPlus main 
window to automatically reduce to an icon for less screen clutter; similar to the Minimize on 
Use option in the program manager. You may elect to minimize ThumbsPlus at any of the 
following times:

When viewing
On copy to clipboard
When editing an image

Auto Remove Orphans. Selecting this will cause ThumbsPlus to scan for orphaned thumbnails
(thumbnails for files that have been removed from another program) whenever you change 
directories, and automatically remove them. You may instead remove orphans manually using 
the Remove Orphans option on the Thumbnail menu.





Options - Confirmations Ctrl+N

This menu selection allows you to configure which items ThumbsPlus prompts for confirmation. 
For example, if you want ThumbsPlus to make sure before deleting files, that option should be 
checked. The dialog box looks like this:

Each option determines whether or not ThumbsPlus will display a dialog box to confirm the 
listed operation after it is selected.



Options - Slide Show Ctrl+S

This dialog box allows you to control the operation during a Slide Show.

Delay between slides. Select either a number of seconds that ThumbsPlus will wait between 
slides, or mark the Control manually checkbox to manually switch slides (using the left mouse 
button or the space bar).

Background color. Select the background color to use for images smaller than the screen.

Stretch bitmaps to fill screen. Causes ThumbsPlus to stretch images to fill the screen as 
much as possible.

Maintain orignal aspect ratios. When stretching bitmaps, ThumbsPlus will ensure that the 
width-to-height ratio remains constant, rather than distorting the image.

Hide cursor. Hides the mouse cursor during the slide show.

Build bitmaps from metafiles. When this checkbox is selected, ThumbsPlus will build an in-
memory bitmap from a metafile before displaying it. This eliminates watching the metafile draw.

Skip files smaller than. When selected, ThumbsPlus will not display raster images smaller 
than the entered size (width and height).



Options - Viewer Ctrl+W

You control the operation of viewing files with this dialog box.

Initial Size

Automatic The size of the view window is based on the size of the image or metafile 
being displayed.

Full Screen The entire screen is used to display the picture, without menu bar or 
caption. See View - Full Screen for more information on this mode.

Maximize The window is maximized.

Minimize The window is iconized.

Stretch images to fit window. Images are stretched to fill as much of the window as possible, 
depending on the setting of Maintain aspect ratio.

Maintain aspect ratio. The ratio between the width and height of the image is kept constant, to 
avoid distorting the image.

Dither Metafiles. Windows Metafiles generally include 24-bit color information. On 256-color 
palette-based displays, these colors will be dithered. ThumbsPlus generates (up to) 236-color 
palettes for displaying metafiles, resulting in much smoother displays. However, generating the 
palette and modifying the metafile display to take it into account slows the display process 
down. Select this option if you are in a hurry. Also select this option if you are using a 16-color or
24-million color display driver.

Images to display concurrently. Selects the maximum number of View windows which 
ThumbsPlus can manage at one time. Select a number between 2 and 40.

Background color. Select a background color for the sides or top if the window is larger than 



the image.

Number of windows. ThumbsPlus can display multiple view windows simultaneously. Once 
this limit is reached, ThumbsPlus will close the oldest window before opening another.



Options - Save All Options Ctrl+Shift+S

This menu selection saves the current ThumbsPlus configuration (profile)as the default when 
starting ThumbsPlus. The information saved includes:
All options in the Options dialog boxes.
The current directory tree options, from the Tree menu.
The Toolbar and Status Line settings, from the Options menu.



Options - Restore All Options Ctrl+Shift+R

Use this selection to set all ThumbsPlus options to their last saved settings, as saved from 
within the dialog boxes or by the Options - Save All Options selection.



 Click on any selection above.
This menu also contains a list of all currently opened windows. Selecting any of these entries 
will cause that window to display.



Windows - Show All F4

Causes ThumbsPlus to display all open view windows (in the order they were opened). 
Minimized (iconized) windows are restored; hidden windows are brought to the front.



Windows - Close All Shift+F4

Closes all opened view windows. If you have selected confirmation on closing modified windows
from the General Options dialog box, ThumbsPlus will prompt you before closing any modified 
windows.



Windows - Minimize All Ctrl+F4

This option will minimize (reduce to an icon) all open view windows. These icons display on the 
normal Windows desktop for easy access.



Help - Contents F1

Displays the Contents section of this help file.



File - Save Ctrl+S

This option saves the current file under its current name. It may be used to save a cropped or 
otherwise modified image. ThumbsPlus currently only supports three formats for saving files: 
Windows Bitmap and Compuserve GIF formats for raster images, and Windows Metafile format 
for vector images.

If the current file has an extension representing another format (such as .PCX or .CGM), it is 
changed to reflect the format being saved (.BMP, .GIF or .WMF).



File - Save As Ctrl+A

This option saves the current file, allowing you to select a file name from a standard Windows 
Save As dialog box. It may be used to save a cropped or otherwise modified image. 
ThumbsPlus currently supports several types to save as: BMP, GIF, JPG, TGA and PCX for 
images, and WMF for metafiles.

Some file types also have optional information (such as comments) which can be saved in the 
file. If there are options available for the type you select, an Options dialog box will appear after 
you click OK in the Save As dialog box.

The JPEG Save Options dialog box even shows a preview of the "lossiness" of the 
compression.

The TIFF Save Options dialog box allows you to set the compression and resolution of the file, 
and to add or modify image comments.

The GIF Save Options allows you to specify the GIF level of the output, and to add or modify 
image comments.

If the current file has an extension representing another format (such as .PCX or .CGM), it is 
changed to reflect the format being saved.



File - Save As - TIFF

Compression.

None is the most compatible with other applications, and fastest to load.

LZW is best for 8-bit color and grayscale, and for 24-bit color files.

CCITT Group 3 and CCITT Group 4 are valid only for bi-level files.

Best Fit will cause ThumbsPlus to use CCITT group 4 for any bi-level files, and LZW 
compression for any others.

Comments. Allows you to edit the contents of the TIFF Description tag.

Resolution. Allows you to set the suggested resolution for the image, in dots-per-inch or dots-
per-centimetre.

Separate color channels. Allows you to store RGB (Truecolor) images in separate red, green 
and blue channels. You should not use this option with LZW compression.



File - Save As - GIF 

GIF files may be saved as the older 87a format, or the newer 89a. Version 89a files can have 
comments, which you can edit by clicking the Comments button.

You can also save GIF files as interlaced.



File - Save As - JPEG

Quality. Select a quality value, between 1 and 100. Values between 25 and 95 are 
recommended. Values below 25 are likely to degrade the image far too much, and values above
95 make the file larger without any appreciable quality increase.

Smoothing. This option is sometimes useful for storing dithered 256-color images as JPEGs; it 
attempts to smooth the differences between pixels caused by dithering, but tends to blur the 
image somewhat.

Grayscale. Stores the image as a single-channel, 8-bit grayscale image. This removes all color 
information from the image.

Comments. Click on this button to edit or add comments to the image file.

Preview. Allows you to see the effect of the lossy compression on the image. You may scroll 
this preview around to different parts of the image to see the effect on specific details. The Delta
option shows the differences between pixels, before and after compression. Medium gray is 
"zero difference."

A truecolor or highcolor (24-bit or 16-bit) display driver is required to utilize the JPEG loss 
preview.



File - Save Palette As Ctrl+P

This option saves the palette of the current file to a .PAL file, which is really just a PCX file with a
different extension. You can use these PAL files (or any bitmap file with a palette) to apply a 
palette to a given picture using the Color Depth dialog box, or even to apply the same palette to 
multiple files in Batch Convert/Edit.

You can make the .PAL files visible in ThumbsPlus by selecting them in the Options - File Types 
dialog box from the main window.

ThumbsPlus .PAL files are not similar to or interchangeable with .PAL files from other 
applications.

ThumbsPlus stores a small (generally 64x64) pixel bitmap along with the palette, so that useful 
thumbnails may be generated from the files.



File - Print F9

This selection prints the graphic in the current view window. All options from the Page Setup and
Printer Setup dialog boxes are applied.



File - Reload Shift+Ctrl+Z

This option reloads the current image from its disk file (the last time it was saved, or the original 
if you havent saved it). It effectively undoes all changes since the last time the file was saved.



File - Close Alt+F4

This option closes the view window and removes it from the screen. If you have modified the 
image and selected confirmation for closing modified images (from the Confirmations dialog 
box), ThumbsPlus will ask you if you wish to save the modified image.



File - Close All Shift+Alt+F4

This option closes all open view windows. If you opted to confirm closing modified images (from 
the Confirmations dialog box), ThumbsPlus will prompt you to save each one before closing it.



 Click on any selection above.



Edit - Clone F8

This menu selection copies the current image to a new window. The file is not re-opened, so 
any changes made already are reflected in the copy.



Edit - Copy Ctrl+C

This menu selection copies the currently selected area in the view window to the clipboard. 



Edit - Crop Ctrl+R

Use this menu option to reduce the view window to only the selected area of the image. 
Anything outside the selected area is eliminated. This change will only be written to the disk file 
if you use the File-Save or File-Save As option. 



Edit - Cancel Selection ESC

This option removes the selection rectangle from the window. 



Edit - Undo Ctrl+Z

This selection restores the image to its state before the last Rotate, resize, Color Adjustment, 
Color Depth, or Crop operation.

This menu item will show what will be undone, or show "Can't undo" if there is nothing to undo. 
Some operations are not saved for undo, as they can be re-selected to undo them.



Edit - Select All Ctrl+E

This option selects the entire contents of the view window for processing.



Edit - Thumbnail from Selection F2

This selection uses the currently selected area in the view window to generate a thumbnail for 
the image. This is especially useful for clipart files which contain many related images. You can 
select a representative part of the file and create the thumbnail from only that part.



 Click on any selection above.
This menu provides options that operate on a selected area in the view window. Only bitmaps 
can be selected from; to operate on a portion of a metafile, it must first be converted to a bitmap
using the View-Convert to Bitmap option.
Use the mouse to select an area in the view window: press the left mouse button to start a 
selection area at one corner, and hold it down while moving the mouse to the opposite corner. 
Then release the mouse button. ThumbsPlus will draw a rectangle around the selected area. If 
the area is large enough, ThumbsPlus will also display the selected area size in a small 
rectangle in the center of the area.

To select an area from the center out, hold the SHIFT key down, press the left mouse button at 
the place you want to be the center of the selection, and drag the mouse to a corner. Then 
release the mouse button.



View - Autosize Window Ctrl+F6

This option will make the view window the same size as the image displayed in it (if possible).



View - Assumed Gamma G

This dialog box allows you to assign the assumed gamma value for an image, and to set the 
default for a file type (so that any files loaded with the given type will be assumed to be adjusted
for that gamma value.)

Use the arrows or the mouse to change the assumed gamma value. Select a value of zero (0.0)
to turn off gamma correction for this image.

Check Set Default for Type to assume the selected value for all loaded images of this file's file 
type.

If you're using a palette-based (256-color) display driver, the change will be immediately visible. 
For 24-bit (truecolor) and 16-bit (highcolor) displays, you must click on the View button to see 
the changes.



View - Maintain Aspect Ratio Shift+F6

This option causes ThumbsPlus to maintain the original file's aspect ratio when stretching to fill 
the window. This applies to both metafiles and bitmaps.



View - Zoom to Fit All F6

When this option is checked, the image will be stretched (or shrunk) to fill the size of the 
window. Note that you cannot select portions of the image when stretched.



View - Zoom to Fit Width Ctrl+W

When this option is checked, the image will be stretched (or shrunk) so that the width of the 
graphic fits the width of the window. This is most useful for portrait-oriented files, such as 
documents.



View - Gridlines L

This option toggles the display of grid lines between pixels when zoomed in by 4x or more.



View - Zoom Out Shift+Z

This function zooms back out after Zooming in.



View - Zoom In Z

This selection "zooms in" on the current bitmap or metafile. For bitmaps, each pixel is shown as 
a square. For metafiles, only a portion of the file is viewed, but at increased magnification.

It is useful for viewing details in an image. It does not modify the image itself -- use Image - 
Rotate/Resize for changing the size of an image.

You can select Zoom In multiple times to view progressively smaller areas of an image. You may
also use the keys 1-9 to zoom from 1x (unzoomed) to approximately 9x.



View - Comments F7

When this option is available, it indicates that the graphic being viewed has comments 
embedded in it. Select it to view these comments. Comment viewing is currently supported for 
the following types of files:

GIF - version 89a comment field

JPEG - COM marker field(s)

TIFF - Description tag



View - Full Screen F3

This option causes the View Window to use the entire screen, without title bar or menus. If the 
image is larger than the screen, you will still have scroll bars. While in full screen mode, use the 
right mouse button or the F10 key to see the View Window menus, which will appear vertically 
instead of horizontally. You can perform any of the View Window commands while in full screen 
mode; however, cropping an image will reduce the window to the size of the cropped image. 
You can select View-Full Screen again or press F3 to exit full screen mode.



Edit - Autocrop F4

This option automatically crops the current image, removing any edges composed entirely of the
same color. The pixel in the bottom left corner of the image is used as the reference pixel. Each 
of the four sides is compared to this pixel; any side entirely of that color is removed. This 
process is repeated for each side until a pixel of a different color is found.



Image - Count Unique Colors U

This option counts the number of colors in an image. For images stored as 8 bits per pixel or 
fewer, it is very fast; but for 24-bit images, it may take a while (and temporarily use up to 2Mb of 
memory). If there is insufficient memory to count the actual colors in an image, ThumbsPlus will 
ask if you want an estimate instead.



Image - Filter - Select Filter® F

This dialog box allows you to select a filter for processing the current image (or group of images 
in Batch mode).

Category. Select the type of filter you wish to apply. Some types available are: Sharpen, Blur, 
Edge Detection, Effects and Noise.

Filter. Select the specific filter from that category. A sample of the results of the filter will be 
shown in the preview to the right.

Diameter. For statistical and morphological filters, you may select the diameter of the aperature 
to use for processing. Larger aperatures will produce more profound effects.

Apply to. Select the channel(s) to apply the filter to. Intensity applies the effect only to the 
intensity (brightness) of each pixel -- the hue is maintained. All channels processes all three 
channels (red, green and blue) separately. And, for some filter types, you may select only a 
single color channel.

Orientation. For linear filters (those defined by a convolution mask) which are not symmetrical, 
ThumbsPlus can rotate the mask to several positions. Select the arrow which represents the 
direction you wish to apply the filter. 

Modify. Click this button to modify the currently selected filter. Note that only linear filters can be
modified within ThumbsPlus. Statistical and multi-pass filters may not.

New. Click this button to add a new filter.



Image - Filter - New Filter® Shift+F

You use this dialog box to modify an existing linear filter or define a new one. Only linear filters 
(defined by a convolution mask) may be modified or added in ThumbsPlus.

Category. Select the category in which this filter belongs. Categories help to locate specific 
filters from the many choices.

Order. ThumbsPlus can apply 3x3, 5x5 or 7x7 filters. This selects the size of the filter. If you 
reduce the size once you've entered values, some will be lost.

Array. Enter the actual pixel accumulation values here. The central value represents the current
pixel being processed. Each pixel is multiplied by the corresponding value in the array and 
added to a total.

Divisor. The sum of pixel x array values is divided by this value. For most filters, this divisor 
should be the same as the sum of values in the array; the    button will place this sum in the 
Divisor field.

Bias. This value is added to the result of (Array x pixels) / Divisor. It is used for some effects, 
such as embossing and etching. It is especially useful when the sum of values in the array is 
zero.

L. Click to force the array to be left-right symmetrical. All values on the left of the array will be 
repeated on the right (and if you change a value on the left, it will automatically change on the 
right). This button is on by default if you edit a filter that is left-right symmetrical.



T. Click to force the array to be top-bottom symmetrical. All values in the top of the array will be 
repeated automatically on the bottom (and if you change a value on the top, it will automatically 
change on the bottom). This button is on by default if you edit a filter that is top-bottom 
symmetrical.

Remove. Click to remove the current filter from the filter list (THUMBS.FLT).



Image - Filter - Last Filter® Ctrl+F

Repeats the last filter selected (using Image - Select Filter) on the current image.



Image - Histogram® M 

This option displays a histogram of the intensity of the image. It shows the relative number of 
pixels at each intensity level. If the values are bunched together, the picture lacks contrast; if 
they are skewed to the left or right, the picture is most likely too dark or too light.

In some cases, equalizing the histogram (using the Equalize button) will improve the 
appearance. ThumbsPlus will attempt to modify intensities to come as close to even levels of 
each as possible.

The histogram is most useful for 256-level grayscale and RGB Truecolor images.



Image - Invert I 

This selection inverts an image -- each color becomes the opposite color, creating a negative 
effect. This is most useful for printing Compuserve stock trend charts (and other dark drawn 
images), which otherwise use lots of toner or ink. It can also be useful for some incorrectly 
stored TIFF or PCX images (marked as MIN_IS_BLACK, but stored as MIN_IS_WHITE).

This option is its own inverse, so it is not saved for undoing.



Image - Swap Red & Blue W

This option swaps the red and blue values of each pixel or color map entry. It is useful for 
images (especially Sun Raster) which are saved with these values reversed. Note that this 
operation is not saved for undo, as selecting it again undoes it.



Image - Flip Vertical V

This option reverses the image from top to bottom. Note that this operation is not saved for 
undo, as selecting it again undoes it.



Image - Flip Horizontal H

This option reverses the image from left to right. Note that this operation is not saved for undo, 
as selecting it again undoes it.



Image - Rotate/Resize R

This dialog box allows you to either rotate or resize an image, or both simultaneously. You can 
also control how the rotation occurs (whether the corners are cut off) using a zoom control.

Zoom percentage. Zooms in or out. This is most useful for controlling what happens to the 
corners of the image during rotation. Use the arrow keys or mouse to slide the control box left or
right to decrease or increase the zoom amount. This option is not available when fitting to the 
bounding box (see below).

Rotation angle. Angle (counter-clockwise) of rotation, in .01-degree increments.

New Size. Various options for the new size of the image, include specific percentages and 
specific sizes. You can also select Window to size the image to the current window size, or 
Custom to enter specific values.

These values may be entered either as exact pixel measurements, or as percentages of the 
original.

Aspect Fit. This selection sets how ThumbsPlus treats an original whose dimensions are of a 
different ratio than the destination. In other words, it controls the size of the destination file.

Fit Both. The final image fits in the specified rectangle as closely as possible.

Fit Height. The final image must be the same height as the specified height.

Fit Width. The final image will be the same width as the specified width.

Bounding Box. Most useful for rotations: the final image size is calculated as the size 
necessary to include the entire image after rotation. This avoids cutting of corners or edges.

None. The aspect ratio of the original is ignored.

Interpolate (resample). Selecting this box (highly recommended!) will cause ThumbsPlus to set
the values of new pixels to averages of surrounding pixels. This requires that the image be 
either 24-bit color or 256-gray level. If it is not, ThumbsPlus will automatically change the color 



depth.

ThumbsPlus remembers the last settings from this dialog box so that you can re-use them for 
additional images, or for batch processing.

If you rotate or resize a 256 (or fewer) color image and select interpolation, ThumbsPlus will 
automatically promote it to 24-bit (truecolor to be able to interpolate intervening pixels. You can 
then use the Color Depth selection to adjust the colors to the number you desire. Likewise, 
ThumbsPlus will promote any grayscale image less that 256 levels to an 8-bit grayscale image.



Image - Turn Ctrl+KeyPad6,2,4

These three options (to turn the image by 90, 180 or 270 degrees) rotate the image quickly. 
Note that you can achieve these same functions (even in batch mode) by using Rotate/Resize 
with an angle of 90, 180 or 270, and specifying Bounding Box as the Aspect Fit.



Image - Color Depth D

Use this window to modify the color depth of an image. For example, it will convert a color 
image to grayscale, or a 24-bit image to 8-bit, or just about anything to monochrome (bi-level).

Desired Color Depth. Select the number of colors you desire in the final image.

Bi-level Selects a two-color (black & white) destination image. Each pixel 
requires a single bit.

Threshhold When you select bi-level as the desired color depth, you may 
enter a threshhold value for the dividing point between black and 
white. This number must range between 1 and 764. The sum of 
red, green and blue values for each pixel is compared to this 
threshhold; if below, the destination pixel becomes black; if above,
it becomes white. Note that if dithering is selected, this value may 
not make as much difference, as any error is propogated through 
neighboring pixels.

16 Colors Selects a sixteen-color destination image; each pixel requires 4 
bits.

236 Colors Selects a 236-color destination image; each pixel requires 8 bits. 
This selection is useful for 256-color Windows users, as it leaves 
the 20 colors that Windows requires.

256 Colors Selects a 256-color destination image; each pixel requires 8 bits.

Truecolor Selects a 24-bit destination image; each pixel requires 24 bits.

Custom Select a number between 4 and 256. For color counts between 4 
and 16, 4 bits per pixel are required; for a count of greater than 16,
8 bits per pixel are required.

Palette. Unless converting to Truecolor, you must select the palette to use. Several fixed and 
optimized palette selections are available:

Optimized (5-bit median cut) Uses the "median cut" algorithm to select a color palette 
that best matches the colors of the original image. Selects from a 
total of 32,768 possible colors (5 bits each for red, green and 
blue).



Optimized (6-bit median cut) Uses the "median cut" algorithm to select a color palette 
that best matches the colors of the original image. Selects from a 
total of 262,144 possible colors (6 bits each for red, green and 
blue). In some cases, this will mean a better color selection than 
the 5-bit algorithm, but it runs somewhat slower.

Optimized (8-bit median cut) Uses the "median cut" algorithm to select a color palette 
that best matches the colors of the original image. This algorithm 
selects from a total of 16 million possible colors (8 bits each for 
red, green and blue). In some cases, especially rasterizing 
drawing with solid areas or gradient fills, this option produces 
much better results that 5 or 6-bit quantization. However, it is quite
a bit slower, and will use very large amounts of memory if the 
number of colors in the original image is high. Not suggested for 
photographic images.

Optimized (popularity) Selects the n most-used colors in the original image.

Grayscale Creates a fixed levels-of-gray palette, with n evenly spaced colors.

ThumbsPlus Color Selects the same colors used in the ThumbsPlus thumbnails; this 
is also the palette used for the Quick Dithering option (see below).

Windows Color Uses the 16 standard Windows colors (yuck - but sometimes you 
need 'em).

Standard VGA Selects the default 16 VGA palette colors.

6x7x6 Even DistributionCreates a palette with 6 levels of red, 7 of green and 6 of blue, 
evenly spaced. (Not very pretty for most images, but okay for 
some dithering jobs.)

6x6x6 Even DistributionCreates a palette with six levels each of red, green and blue, 
evenly spaced. This is similar to the 6x7x6 palette, but more useful
for pictures with large amounts of gray.

Indeo Uses the 236-color Indeo palette recommended for video frames. 
This is also a very useful general palette, somewhat similar to the 
ThumbsPlus palette.

Cinepak Uses the recommended 236-color Cinepak palette recommended 
for video composition.

Pasted from Clipboard Pastes a palette from the image on the clipboard. This is useful for
adapting several images to a common palette.

Loaded from File This option allows you to load a palette from an existing graphics 
file, or from a ThumbsPlus palette file (.PAL), which you may 
create using the Save Palette As... option on the View window File
menu.

Identity palette. Checking this box will cause ThumbsPlus to adjust any 17 to 236 color palette 
to be a Windows identity palette, placing the 20 Windows system colors in the first 10 and last 
10 color map positions.

Dither. When reducing the number of colors in an image, you may select a dithering method 
from those listed below.



(none) No dithering. Colors are simply mapped to the closest available 
color in the selected palette.

Floyd-Steinberg The most popular error diffusion dithering method. Fairly quick 
with reasonable results.

Burkes Another error diffusion dither. Takes slightly longer than Floyd-
Steinberg, and sometimes produces nicer results.

Stucki A fairly complex error diffusion dither. Slower than Floyd-Steinberg
or Burkes, but usually the nicest results, especially for truecolor to 
256-color conversions.

Quick Uses the ThumbsPlus palette to very quickly dither an image to 
256 colors. With truecolor images on a 256-color display, this 
option will produce the same results as displayed in the window.

ThumbsPlus retains the last selections you made in this window so you can apply the identical 
changes to subsequent files, or during batch processing.



Image - Color Adjust C

Use this selection to alter the brightness, contrast, gamma and red, green and blue levels in an 
image.

Brightness. This control changes the overall brightness of an image. Use negative values to 
darken an image, and positive values to lighten it. Use the arrow keys or the mouse to change 
the value.

Contrast. This control changes the contrast; that is, the difference between the light and dark 
areas. Positive values increase the difference between them, while negative values decrease 
the contrast.

Gamma. This control changes the color values or gray levels in an image to provide for a 
specific gamma correction. The display itself doesn't change (because ThumbsPlus knows the 
new assumed gamma value, and adjusts for it!), but the image itself does. This is most useful if 
you have linear files (gamma = 1.0), and wish to make them "standard" GIF files (gamma = 2.0),
so they will display reasonably correctly with viewers which don't provide gamma correction.

R, G, B. These controls modify the amount of Red, Green and Blue in the image. They work 
similarly to the Brightness control, but individually on each color channel.

None. Sets all controls to zero.

View. On Truecolor or Highcolor displays, this button repaints the image with the selected 
changes. This button is absent on 256-color displays, as ThumbsPlus automatically animates 
palette of the image to show the changes.

Note that ThumbsPlus "remembers" the last values you used to adjust an image, so you can 
use them to adjust another, or as input to Batch processing of images.



Image - Convert to Bitmap F5

This option converts a metafile to a bitmap. You may enter the desired height and width, and 
whether or not to maintain the original aspect ratio of the metafile. 

Width.    Enter the desired width of the bitmap. This defaults to the current window width.

Height.    Enter the desired height of the bitmap. This defaults to the current window height.

Maintain aspect ratio.    Select this option to force the bitmap to be the same aspect ratio as 
the original metafile. This defaults to the setting of the Maintain Aspect Ratio option in the View 
window.



 Click on any selection above.



 Click on any selection above.



ThumbsPlus

This "quickie" menu, which has no drop-down items associated with it, simply brings the 
ThumbsPlus main window to the top of all windows. It is useful when a large view window 
obscures or covers the ThumbsPlus main window.



View Window

The View Window provides a simple way to view and globally edit (crop, color adjust, modify 
color depth, rotate, resize, filter, invert, flip, etc.) graphics images from within ThumbsPlus. You 
can also save modified files in various formats. The View Window provides the following menu:

 Click on any selection above.



Selecting Files

You select files from the file list (the area of the screen with thumbnails) by using the mouse or 
keyboard.

Using the Mouse to Select Files

You can use a mouse to select a file or group of files. Before you can select files, they must be 
visible in the file list.

To select a file:
Click the filename or thumbnail.

To select multiple items in sequence:

1. Click the first file you want to select.

2. Press the  key while you click the last file to select.

To select two or more file out of sequence:

Press and hold  while you click on each file.

To cancel the selection of a file:

Press and hold  while you click the selected file.

Using the Keyboard to Select Files

You can use the keyboard to select a file or group of files. Before you can select files, they must 
be visible in the file list.

To select a file:
Use the following keys to select a file or directory. 

Press To select

A file above or below the current selection. 

The last file in the list. 

The first file in the list. 

The file at the top of the previous screen. 

The file at the bottom of the next screen. 

To select two or more items in sequence:



1. Use 

 to move to the first file you want to select. 

2. Press and hold down  while you select the remaining files.

To select two or more items out of sequence:

1. Use the arrow keys to move to the first file you want to select.

2. Press and release 

. The selection cursor begins to blink.
3. Move to the next file you want to select.
4. Press the SPACEBAR to select each file.

5. Press 

 when you finish selecting files.

To cancel the selection of a file:

1. Press and release 

 so that the selection cursor begins to blink. 
2. Move to the selection you want to cancel, and then press the SPACEBAR. 

3. Press 

 when you finish canceling selections. 



Hints and Tips

File Manager Drag & Drop. ThumbsPlus will act as a drag-and-drop client from File Manager. 
Simply drag file names from File Manager to the ThumbsPlus window (or icon). ThumbsPlus will
open a view window for each file (up to the maximum number of view windows specified in the 
Viewer Options). You can also drag files from ThumbsPlus to other applications.

View Window Shortcuts. Double-clicking with the left mouse button in a view window will 
change it to full screen mode. Double-clicking with the right mouse button in a view window will 
close the window.

Metafile Viewing. If you're displaying true-color (24-bits) or standard VGA, turn on "Dither 
Metafiles" from the Viewer Options dialog box. In the case of true-color, Windows never dithers; 
in the case of standard VGA, the special code to create solid colors for the dithered colors 
cannot work.

Background Colors. For full-screen displays of 256-color images on a palette-based (256-
color) display, select either black or white as the background color from the Viewer Options or 
the Slide Show Options dialog box, as ThumbsPlus steals the other system colors to more 
accurately display the image.

Internal Drag & Drop. Although ThumbsPlus has only a single window, you can drag files to 
directories not visible on the directory list by scrolling it after selecting the files you want to 
move or copy.

Performance. Though there is no built-in limitation on the number of file ThumbsPlus can 
handle, I recommend creating multiple catalogs (databases) if you have more than about 5000 
files. Besides reducing the memory required to handle the index, smaller catalogs will speed up 
access to thumbnails in the database.



Thanks To...

Many thanks to everyone involved in the development and testing of ThumbsPlus. I would like 
to offer special recognition to:

Cricket, Adam, Rachel, Leah and Evan Crews, my wife and children, for putting up with me 
during the continuing development of ThumbsPlus.

Laura Shook, for her incredible devotion, unflagging support, and for being so wonderful to 
work with.

David Hanna, for excellent suggestions and great insight into what ThumbsPlus should become
(and I hope it has!).

Pat O'Sullivan, for the most thorough testing any developer could hope for from a single 
person.

Mike Edgerton, for the diverse Program Manager icons you have to choose from. (Select 
Properties from the File menu in Program Manager, then click on Change Icon to see them!)

Tom Lane and the Independent JPEG Group. Many thanks for routines that are well-written, 
easy to understand, straightforward to implement, and were simple to integrate into 
ThumbsPlus.

The members of the 'Go Graphics' Group who have supported and encouraged us: Matt 
Drury, Mike Edgerton, Bruce Herzog, Ray McVay, John Parker, Tom Potocki, Tom Price, 
Howard Thue, Larry Wood and more.

Our overseas shareware and retail distributors: Pat O'Sullivan (Australia and New Zealand), 
Kenji Hino and Mr Nakamura at Village Center (Japan), Patrick Hochner at P&A Shareware 
(Japan), Hans Fremuth, Jupp and Franz Grieser at Kelly Data (Germany), Gerd Zottelein at 
PD Profi (Germany), Nick Thompson at The Thompson Partnership (UK).

Other people who have greatly encouraged or affected ThumbsPlus: Joel Diamond, Ed 
Hoffman, Jeff Hurley, Ralph Mariano, Hugh McArtan.



Windows Video Drivers

By default Microsoft Windows uses a fixed 16-color display driver (called the Standard VGA 
driver). This driver is fine for text-based or minimally graphic applications, but falls down heavily 
when confronted with multi-colored graphic files, like GIFs and JPEGs. Using a 16-color driver, 
graphics appear grainy, grayish and generally ugly, because Windows maps them to the 16 
Windows colors. 

Most systems purchased within the last few years have contained Super VGA video cards, 
which require special video drivers for Windows. Usually, a diskette with Windows drivers 
comes with the system. Occasionally, the drivers are pre-installed on the system and available 
to Windows. Also, if you've upgraded your video card, you should have received Windows 
drivers with it.

Installing the Drivers

To install the drivers, have your driver disk and your Microsoft Windows installation disks handy. 
Then, follow these steps:

1. From Program Manager, run Windows Setup. (If you're running Windows for Workgroups, 
you must run the SETUP program in the Windows directory from DOS).

2. Select Change System Settings... from the Options menu.

3. If your drivers have been pre-installed, scroll through the display list and find an appropriate
driver. Select this driver, then click OK. You may have to restart Windows to make the 
change effective.

4. If you have to install the driver from a diskette, pick the entry labeled Other display (Requires 
disk from OEM)...

5. Insert your diskette when prompted; you may also have to insert one or more Windows 
installation disks.

6. Pick an appropriate driver and click OK.

If you have problems starting Windows after selecting a video driver, run Windows Setup from 
DOS to select the original (VGA) driver:

C:\> CD \WINDOWS
C:\WINDOWS> SETUP

Selecting a Driver

Several different color depths and screen resolutions may be available; here is some 
information on the possible choices:

Four different color depths are generally considered "Super VGA;" these are:

256-color (8 bits required per pixel)



This provides the minimum number of colors to display a single color graphic; multiple 
graphics must usually share some colors, so quality is sacrificed on all but the "top most" 
window. 24-bit graphics must be pre-processed before display to achieve reasonable color; 
ThumbsPlus uses a fast "quick-dither" to the thumbnail palette. This is indicated by a [Q8] 
appended to the file name in the view window title bar.

32768-color (16 bits required per pixel)
This mode divdes the 16 bits into 5 red, 5 green and 5 blue pixels. One pixel is not used. 
This provides much better viewing capability than the 256-color mode, but requires more 
video memory. You can simultaneously view multiple 256-color graphic files. Truecolor (24-
bit) files will suffer some loss in quality (because nine bits of each pixel are ignored), and 
may be somewhat slower to display because the video driver has to "map" the colors.

65536-color (16 bits required per pixel)
This mode provides similar capability to the 32768-color mode, with (very) slightly better 
results. The extra (16th) bit is usually used for green.

16-million color (24 bits required per pixel)
Eight bits are used for each color (red, green, blue). This provides true color viewing -- no 
color information is lost from 24-bit images, and as many as desired may be viewed 
simultaneously. This is the most accurate color mode, but generally slower than 256-color 
mode.

Your video card may be capable of several different color depths and several different 
resolutions. Here is a table showing the minimum amount of video memory required for most 
popular color resolutions for each color depth, rounded up to 512Kb (Kilobytes) increments. 
Note that video memory is separate from system memory -- it's on the video card itself, and not 
usuable for programs or data.

256 (8-bit)
32768/65536

(Hicolor)
16.7 Million
(Truecolor)

640x480 512Kb 1Mb 1.5Mb

800x600 512Kb 1Mb 2Mb

1024x768 1Mb 2Mb 2.5Mb

1280x1024 1.5Mb 3Mb 4Mb

1600x1200 2Mb 4Mb 6Mb

Video cards with less than 512K of memory are not capable of running Windows with more than
16 colors.

Your monitor must also be capable of displaying the required vertical and horizontal resolution.

Using higher color depths also requires more system memory, as bitmaps are often stored in 
system memory at the color depth (bits per pixel) required for the current display.



Supported File Types

The list below shows the file types that ThumbsPlus supports. If there is additional information 
available, the file type is underlined.
.AVI ®Video for Windows files
.BMP,.DIB,.RLE Windows Bitmap files
.CDR,.PAT,.BMF CorelDRAW, CorelGALLERY
.CEL AutoDesk Animator CEL files
.CGM Computer Graphics Metafile (binary encoding)
.EPS Encapsulated Postscript files (preview image only)
.GEM GEM Metafiles
.GIF CompuServe Graphics Interchange Format files
.ICO Windows Icon files
.IFF,.LBM Amiga IFF format
.IMG GEM Image format
.JPG,.JFI,.JIF JPEG compressed files (in JFIF format)
.MND,.MNI Mandelbrot for Windows image files
.MOV ®QuickTime Movies
.PCX,.PCC ZSoft Picture files
.PCD Kodak PhotoCD files
.PSD Adobe Photoshop files
.RAS,.SUN Sun Raster format
.RAW Raw grayscale images
.TGA,.WIN Targa TruevisionTM files
.TIF Tagged Image Format files
.TTF,.TTR TrueType fonts
.WMF,.MF Windows Metafiles and Placeable Metafiles
.WPG DrawPerfect graphics files



BMP, DIB, RLE: Windows Bitmaps

This is the standard bitmap format supported by Microsoft Windows. ThumbsPlus supports all 
color depths (1, 4, 8 or 24 bit), and the compressed (RLE) formats for 4-bit (RLE4) and 8-bit 
(RLE8) bitmaps.

The standard VGA driver does not properly decompress 8-bit compressed BMP files; for best 
color viewing (and nicest thumbnails), you should load a 256-color or higher Windows video 
driver, which should eliminate this problem.

Some proprietary 8-bit drivers do not properly decompress 4-bit compressed files, though the 
situation is always improving, and this problem is becoming much less common.

ThumbsPlus currently writes only uncompressed BMP files.



GIF: CompuServe GIF

The GIF format was developed by CompuServe, an on-line service, to provide good file 
compression and relatively fast decompression speed. GIF is a very popular format for online 
services, but is limited to a maximum of 256 colors.

Two standards have been developed: 87a and 89a. ThumbsPlus fully supports the 87a 
standard, and will view comments from 89a files. Multiple-image, multimedia, text, and input 
extensions are not supported.

ThumbsPlus can read interlaced GIF files, but always saves in non-interlaced format.



PCX, PCC: ZSoft Picture

PCX and PCC files are a fairly early PC graphic format, which has been extended over the 
years to support more and varied color depths.

The only known PCX format not supported by ThumbsPlus is 2-plane CGM files (4 color). These
files may be supported in the future if there is sufficient interest.

ThumbsPlus does support 24-bit (3-planes x 8-bits per pixel) PCX files.

PCX files may or may not be compressed; ThumbsPlus always writes version 5, compressed 
PCX files, in the color depth of the current image.



TGA, WIN: Targa TruevisionTM

ThumbsPlus supports 8-bit, 16-bit and 24-bit Targa files. The more recent Targa extensions 
(including the "Developer Area") are not yet supported, but planned for a subsequent release.

The alpha channel information not currently retained.

ThumbsPlus saves TGA files at the appropriate color depth for the graphic; 4-bit (16-color) files 
are promoted to 8-bit Targa files.



ICO: Windows Icons

ThumbsPlus supports Microsoft Windows icon files, which are associated with applications for 
display in Program Manager or alternate shell programs.

256-color icons are handled, but not well tested because of a general lack of availablity of 256-
color icons.



JPG, JIF, JFI: JPEG (JFIF) Files

The JPEG format was developed to provide a high degree of compression for images. It is a 
"lossy" compression method, meaning that some color information from the original is lost. 
When saving JPEG files, ThumbsPlus allows you to specify the intended quality of the image.

JPEG is generally appropriate for photographed or scanned images, and works best for 24-bit 
sources. JPEG is generally inappropriate for any type of line-drawn art.

The JFIF specification describes a standard way to incorporate JPEG images in disk files; only 
JFIF images are supported by ThumbsPlus. Some software (notably GIF2JPG, by Handmade 
Software), writes non-JFIF files which ThumbsPlus cannot handle.

ThumbsPlus incorporates the Independent JPEG Group's source code (V4), and supports only 
baseline JPEG images.

Lossless JPEG is not currently supported. For lossless storage of 24-bit images, use Targa, 
BMP, or PCX.

ThumbsPlus allows several loading options for JPEG files. When using a 256-color display, the 
JPEG file may be reduced to 256 colors during loading. This is not recommended if the image is
going to be edited. See JPEG Load Options.

For more information on saving in the JFIF format, see JPEG Save Options.

ThumbsPlus uses version 4 JPEG code to handle JFIF files and may not recognize some files 
created with earlier or later releases. Also, some programs create proprietary (non-JFIF) format 
files also called ".JPG", which ThumbsPlus does not recognize.



TTF, TTR: TrueType fonts

ThumbsPlus can thumbnail, install, and remove TrueType fonts.

The default format of the thumbnail is to show the font name in the font itself. The text in the 
thumbnail may be changed using the TrueType Loading Options dialog box.

When installing and removing fonts, ThumbsPlus updates the WIN.INI file to reflected the added
or deleted fonts. ThumbsPlus never deletes TTF files from the disk (unless, of course, you use 
File-Delete.



MND, MNI: Mandelbrot for Windows images

Mandelbrot for Windows is another Cerious Software product, which generates Mandelbrot set 
fractals. The files generated by this program may be thumbnailed and viewed in ThumbsPlus.

MNI files contain information about generating the image only, but may contain a preview 
bitmap. This preview can be extracted by ThumbsPlus from these files.



CDR, PAT, BMF: CorelDRAW and CorelGALLERY

ThumbsPlus can create thumbnails for CDR, PAT and BMF files; however, it can only extract the
preview bitmap from them. There is no internal support for the proprietary Corel format.

If you have Corel, you can set up CDR and PAT files for external OLE    support (using the File 
Type Configuration dialog box), which will allow you to create much nicer thumbnails for them. 
However, the price is high: Corel is a very slow OLE server, so it takes much longer to create 
the thumbnails.

Corel files may also be viewed, printed, or copied to the clipboard as metafiles using the OLE 
support.

CorelGALLERY files (.BMF) can be viewed and thumbnailed via OLE also, as long as the Corel 
Gallery program itself is installed. As with the CDR files, OLE is considerably slower than the 
internal bitmap support.



EPS: Encapsulated Postscript

EPS files are Postscript language files, created for Postscript printers. ThumbsPlus can access 
only the preview image (which can be in either TIFF or Windows Metafile format).

Copying this format to the clipboard or otherwise saving or converting it only accesses this 
preview; the Postscript contents themselves are not accessed by ThumbsPlus.



IMG: GEM Images

The IMG format was originally designed for the Atari computers, then migrated to PCs for 
several GEM-based products, including Ventura Publisher. IMG files may also be embedded in
.GEM metafiles.

ThumbsPlus supports reading of all known IMG types, but does not currently correct the aspect 
ratio for files with non-square pixels.



IFF, LBM: Amiga and Deluxe Paint

The IFF format is an Amiga image storage format. LBM was created for the Deluxe Paint 
package, and is essentially the same. ThumbsPlus supports all known IFF and LBM formats 
except HAM and Dynamic HAM, which may be supported in the future.



TIF: Tagged Image File Format

The Tagged Image Format was developed by several companies, including Aldus, to be the be-
all and end-all of image file formats. Because of its scope and extensibility, it is an extremely 
complex format which no single product can support completely.

TIFF is a clear example of the danger of design by committee.

The known TIFF formats not yet handled by ThumbsPlus are:

· Images in YCbCr (YUV) or proprietary color formats.
· Multiple-image TIFFs (only the first image is accessed)
· JPEG-in-TIFF (JTIF) (let's take two very complex file formats and cram them together. 
That should make things better.)

The following compression methods and special-interest formats are supported:

· Tiled TIFFs
· CCITT RLE, Group 3, and Group 4 Fax compresions
· Packbits, Thunderscan and Next compresion
· LZW compression
· Motorola (MM) format

ThumbsPlus writes uncompressed TIFFs, or compressed via CCITT Group 3 or 4 FAX, 
Packbits, or LZW.



CGM: Computer Graphics Metafile

CGM files are vector graphic files useful as clipart. They scale well, and have the distinction of 
being the only ANSI standard graphic format. There are many flavors of CGM files; ThumbsPlus
supports the most popular for PCs (binary encoding), with the following limitations:

· Embedded cell arrays (bitmaps) are not supported.
· New (version 3) extensions, such as Bezier curves, are not supported.
· Font support is incomplete
· Rotated (non-orthogonal) ellipses and elliptical arcs are not correctly rendered.
· Hatches are rendered with the closest hatching format available from Windows.



RAW: Raw Grayscale

Raw grayscale images are 256-level grayscale images stored with no header information; the 
horizontal and vertical widths are inferred from the size of the file, based on entries in the 
THUMBS.INI file:

[Raw]
Sizes=1024x512*2,1024x1024

This example tells ThumbsPlus that two sizes of Raw grayscale files should be recognized: 
1024x512 (524288 byte) and 1024x1024 (1048576 byte). The '*2' on the first entry tells 
ThumbsPlus to replicate each input scan line, generating a 1024x1024 image. Some medical 
imaging systems generate grayscale files for which this transformation is appropriate.



PCD: Kodak PhotoCD Images

Kodak PhotoCD files are a proprietary format developed by Kodak for photographic image 
storage. They are generally located on CD-ROM only, due to their extremely large size. They 
may be loaded at various resolutions.

ThumbsPlus can load at any of the following resolutions:

· Base/64 (96x64)
· Base/16 (192x128)
· Base/4 (384x256)
· Base (768x512)
· Base*4 (1536x1024)

ThumbsPlus can load as either Truecolor, 8-bit palettized or as grayscale files. Use the Photo 
CD Loading options dialog box to select the desired size and color depth for loading PhotoCD 
files.



WPG: Word Perfect Graphics

WPG files are a vector (metafile) format that WordPerfect Corporation developed for use with its
word processing products. Like other formats, WPG has evolved over the years.

ThumbsPlus supports both the original WPG (WPG1) and new (WPG2) formats for graphics; 
some charting and textual items aren't supported in WPG1, and the following are not supported 
in WPG2:

· Poly B-Splines.
· Complex polygons (components are rendered and filled separately).
· Object group rotation, skew, taper and translation.
· Text items are partially handled.
· Bitmaps are not rotated, skewed or tapered.
· Gradient fills are partially supported.



PSD: Adobe Photoshop

PSD files are the native format used by Adobe Photoshop. There are various "flavors" of PSD 
files; ThumbsPlus can read most of them (as of Photoshop 2.5), with the following known 
limitations:

· L*a*b color space PSD files cannot be loaded.
· Only the first channel of multi-channel PSD files is loaded (as grayscale).
· Duotone files are loaded as grayscale.

Version 3.0 PSD files may be read as long as they are flattened (ThumbsPlus cannot handle 
multiple PSD layers).



WMF, MF: Windows Metafile

The Windows Metafile format is the standard Windows format for storing vector and metafile 
graphics. It is quite powerful, as anything that can be drawn on the screen or printed on a printer
can be stored in a metafile. It does, however, lack several rather rudimentary graphics 
primitives, such as Bezier curves and non-orthogonal ellipses.

ThumbsPlus can read and write Windows metafiles; vector graphics are also passed to and 
from the clipboard in this format.

Also, using OLE to load or thumbnail proprietary formats most often uses Windows Metafiles as 
the format for transfer of the picture of the file.



GEM: GEM Metafile

GEM Metafiles are vector graphic files which include drawing commands for rendering pictures. 
They are similar to, but less complete than, CGM files. GEM files originated on the Amiga, and 
have gone through several enhancement periods.

ThumbsPlus does not claim to support all GEM files at this time; fonts are not handled very well,
and curve support is incomplete. However, the support is sufficient for most clip-art, the most 
common type of file stored in GEM format.



CEL: AutoDesk Animator Cel Files

ThumbsPlus supports both the earlier and newer versions of .CEL files. The later version is a 
single-frame .FLC file.



AVI: Video for Windows®

AVI is the standard Windows video format.

The registered version of ThumbsPlus supports playing, viewing, and thumbnailing (any frame) 
of Video for Windows files.

Video for Windows version 1.1d or later must be installed to play AVI files.



MOV: QuickTime for Windows®

MOV is the standard Macintosh video format.

The registered version of ThumbsPlus supports playing, viewing and manual thumbnailing (from
any frame) of QuickTime files.

Apple QuickTime for Windows must be loaded on the system to play MOV files. MOV files must 
be flattened to play on Windows. This means that the Macintosh resource and data file forks 
must be combined into a single file.



RAS: Sun Raster

Sun Raster files are a popular image format for SUN Unix systems. They can contain either 
color-mapped (256-color) or truecolor images.

Many packages write the colors reversed (Red for Blue, Blue for Red), without setting the 
appropriate flag in the header. You can use "Swap Red and Blue" from the Image menu of the 
view window to correct such files.



 Click on any selection above.



Help Menu 

This menu provides access to the ThumbsPlus Help system and the About box.



Japanese Version



German Version

Deutsche Version exclusiv lizenziert von:

Kelly Data GmbH
Lena-Christ-Straße 50
82152 Martinsried

Tel: 089 / 895 6260
Fax: 089 / 895 626 99



Ordering in the U.K.

Please contact:

The Thompson Partnership
Lion Buildings,
Market Place,
Uttoxeter,
Staffordshire
ST14 8HZ

Phone: (0) 1889 564601
CompuServe: 70007,5560
Internet: Fay@ttp.co.uk



Ordering in Japan (English version)

Please contact:

P.&A. Shareware Distribution
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196 Japan

Tel: 0425-46-9141
Fax: 0425-46-9142
Compuserve: 76663,124

Niftyserve: PAF02461



Ordering in Denmark (English version)

Please contact:

Kelds Shareware
Aabrinken 3
7850 Stoholm Denmark
Compuserve: 100342,1543



Ordering in Italy (English version)

Please contact:

DIEMME EDITORI srl Editoria & Informatica
Sede legale e amminstriva:
Via Kennedy III trav, 4 - 87030 Rende (CS)
Tel (0984) 466800 Fax 466801

Avviamento e spedizioni:
Piazzale Kennedy, 6 - 87030 Rende (CS)
Tel (0984) 466883



Ordering in Germany (English version)

Registrier-Formular
( für Bestellungen beim PD-PROFI)

Name ________________________________________________
Firma ________________________________________________
Straße ________________________________________________
Plz/Ort ________________________________________________

________________________________________________

Tel. _______________________________________________
Fax. _______________________________________________
EMail _______________________________________________

Hiermit bestelle ich zu Ihren Geschäftsbedingungen:

___x    registrierte Version Thumbs+Plus DEM 59.-- deutsch 
___x    registrierte Version Thumbs+Plus DEM 59.-- englisch
Porto/Verpackung Inland DEM 10.--
Nachnahme zuzüglich DEM 5.--

total: DEM _____

Zahlungsweise: Visa    (    )      MC    (    )      AMEX    (    )      Scheck/bar    (    )      
Lastschrift    (    )      Nachnahme    (    )

Lastschrift: Kontoinhaber: _____________________________
Kontonummer:_____________________________
BLZ: _____________________________
Bank: _____________________________

Kreditkartenbestellungen:
Karten-Nummer: ______________________________    gültig bis:    ____/____
Karteninhaber:    __________________________________

Auslandskunden erfragen die Preise bitte telefonisch oder per Fax. 

Unterschrift (des Erziehungsberechtigten)    _______________________________

Bitte senden oder faxen an:

PD-Profi Zöttlein Software Vertriebs GmbH Tel.    +49-8432-1296
Schulstr. 13 Fax. +49-8432-8674
D-86666 Burgheim-Wengen CIS. 100326,53



Ordering in Australia, New Zealand and PNG

 Click here for the order form.

Australian Shareware Registration Price List

Cerious Software - SOLE Authorised Agent for Aust., PNG & NZ.
THUMBS+PLUS! v2.0d/v2.1 Graphics file manager, editor, previewer & cataloguer for Windows

AUS$80

THUMBS+PLUS! PRINTED MANUAL*
A4 size , thermal bound $15

THUMBS+PLUS! MANUAL ON DISK*
(.TIF or W4W v6 format) $5

THE MANDELBROT SET v3.0a
Random graphics generator for Windows $40

All programs are available as shareware at $10 for the first disk & $5 ea for subsequent disks 
(rebateable if programs ordered are registered within 30 days).

* All Manuals and Utilities Disks are available to REGISTERED USERS ONLY

Registration fees may be made by cheque/money order made out to:- Patrick O'Sullivan 
(address below) or by direct deposit. Deposit/Credit slips are available at any National Australia 
Bank branch. Just fill in the date, deposit amount and the appropriate boxes as follows:-

Branch name Prahran - Dandenong Credit Union Co-Operative Ltd.
Account name CREDIT P.O'Sullivan
Branch BSB number 083 422
Account number 10806 7706

and on the reverse of the deposit slip:-
Name and address of depositor.

Please include the above information with your order by fax, E-mail or post to any of the 
addresses at the bottom of this page.

n.b. Please remember to keep the completed & stamped stub of the deposit slip as your
proof of payment.

Patrick O'Sullivan
PO Box 65
Armadale Vic 3143
Ph: (03) 509-5250



Fax: (03) 576-0801
CIS: 100240,273
Discovery: 350952500
Internet: pat@ozonline.com.au
Internet: pat@melbpc.org.au

Site & Corporate licences are available upon enquiry.



Order Form - Australia, New Zealand, PNG

Registration Details/Shareware Order Form

Your Full Name:__________________________________________
       Company:__________________________________________
       Address:__________________________________________
              :__________________________________________
              :__________________________________________
              :__________________________________________
    Home Phone:________________________________(Optional)
    Work Phone:________________________________(Optional)
E-Mail Address:__________________________________________

Preferred Disk Format: 1.2___ 1.44___

Programs ordered:_________________________@________
                :_________________________@________
                :_________________________@________
                :_________________________@________
                :_________________________@________
                :_________________________@________
                :_________________________@________
                                     TOTAL:________
Remit to:

Patrick O'Sullivan
PO Box 65
Armadale Vic 3143
Ph: (03) 509-5250
Fax: (03) 576-0801
CIS: 100240,273
Discovery: 350952500
Internet: pat@ozonline.com.au
Internet: pat@melbpc.org.au

Site & Corporate licences are available upon enquiry.



Site Licenses

Cerious Software offers corporate and site licensing for ThumbsPlus. These licenses provide all 
major upgrades to ThumbsPlus for one year, unlimited support by telephone or electronic mail 
(CompuServe or Internet), and maintenance releases when required.

Licenses may be upgraded for the difference between the price paid for the original license and 
the current cost of the new license. Licenses may be renewed each year for 25% of the license 
cost. This will continue the updates and support for an additional year.

Site Licenses

Cerious Software will provide a single distribution, which may be installed on the number of 
licensed systems or placed on an internal company network for use by the number of licensed 
users.

LPK-5 5 users $    180.00
LPK-10 10 users 350.00
LPK-25 25 users 825.00
LPK-50 50 users 1,500.00
LPK-100 100 users 2,500.00
LPK-200 200 users 5,000.00

Concurrent Usage Licenses

Cerious Software will provide a single distribution kit, which may be installed on a network-
available system to be used by no more than the licensed number of users at any given time.

CPK-5 5 users $    250.00
CPK-10 10 users 500.00
CPK-25 25 users 1,250.00
CPK-50 50 users 2,500.00
CPK-75 75 users 3,750.00
CPK-100 100 users 5,000.00

Corporate License

This license offers use of ThumbsPlus on unlimited computers in the licensed organization. 
Cerious Software will provide distribution for up to ten (10) sites, each of which may be installed 
on as many machines as desired, or placed on internal company networks. Cerious Software 
reserves the right to limit the scope of the definition of "organization."

LPK-CORP unlimited users $7,500.00

Prices are in US dollars, effective 4/1/95, and subject to change without notice.



 License

ThumbsPlus is supplied "as is". The author disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any purpose. 
The author assumes no liability for damanges, direct or consequential, which may result from 
the use of ThumbsPlus.

ThumbsPlus is provided free of charge for a thirty day evaluation period. Any use beyond this 
period requires that ThumbsPlus be registered with the author, Cerious Software). This 
registration fee will license one copy of ThumbsPlus for use on a single computer. Site licenses 
are also available.

If you wish to distribute ThumbsPlus, alone, as part of a package, or in any publication, and 
receive any type of remuneration, you must contact Cerious Software for authorization and 
terms.

If you believe ThumbsPlus is valuable and useful, please give it to anyone else you think would
be interested, and encourage them to register their copy.

ThumbsPlus may not be distributed as part of or for use with any commercial 
product without express written permission from Cerious Software. For 
information about the CD-ROM Developer's Kit for ThumbsPlus (Thumbs+CDK), 
please contact Cerious Software.

License statement required by Unisys Corp. for licensing LZW compression:

Use of this software is permitted only to the extent reasonably required to determine whether to purchase the 
software.

After payment is made, use of this software is limited to use on only a single personal computer or workstation 
which is not used as a server. An additional payment is required for each use on another personal computer or 
workstation.

Only a single copy may be made of this software solely for backup or archival purposes. The software may also be 
transferred to a single hard disk.

Any use of this software in viaolation of the above is not licensed.

For information concerning licensing the LZW compressions and/or decompression capability, please contact:

Unisys Corporation
Welch Licensing Department - CISW19
Township Line & Union Meeting Roads
P.O. Box 500
Blue Bell, PA 19424 USA



Ordering Information

 Click here for the order form.

Here's what Adam, Leah and Evan Crews think of people who use ThumbsPlus past the 30-
day evaluation period without registering!

ThumbsPlus is distributed as shareware for evaluation for thirty days (see License). Please 
remember that using unlicensed shareware past the evaluation perioud is unethical and illegal. 
To register and receive the latest version    of ThumbsPlus, please complete the order form and
include US$50.00. In Canada and Mexico, please add $2.00 for shipping. From other countries 
outside the U.S., please add US$5.00 for international postage and handling.

ThumbsPlus has been localized in German and Japanese.

You may place orders for the English language shareware version directly with a distributor in 
the following countries:

Australia

Denmark

Germany

Italy

Japan

U.K.

CompuServe ThumbsPlus may also be registered on-line    via "GO SWREG." The 
registration ID for a single-user ThumbsPlus license is 1357. There is an 
additional charge of US$5.00 for this service. You may also register several 
of the site license options via SWREG.



Telephone orders by credit card are accepted through the Public 
Software Library. There is a handling charge of US$5.00 for the 
Public Software Library.

Voice:  800-242-4775

        713-524-6394

PsL will notify us the day of your order and we will ship the 
product directly to you. Any questions about the status of 
shipment, refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc., must
be directed to Cerious Software directly (see below).

You may fax Mastercard and Visa orders directly to Cerious 
Software at 704-529-0497.

ThumbsPlus Site Licenses are also available!

Prices are subject to change without notice.



ThumbsPlus Order Form

 Click here to print this order form on 8.5x11 or A4 paper in portrait mode. If you do not have a printer, please
write or type the information requested below.

I like ThumbsPlus and want to register it. I understand I will receive the latest version, a printed manual, support via 
the Internet, Compuserve, America Online or telephone, and the peace of mind that comes with "doing the right 
thing."

Name

Organization

Address

City State Country Zip/Postal Code

Telephone number E-mail address(es)

Please let us know where you obtained ThumbsPlus:____________________________________

Quantity License Price (USD) Quantity License Price (USD)
    ____ Single-user $      50     ____ 5 user concurrent 250
    ____ 5 user site 180     ____ 10 user concurrent 500
    ____ 10 user site 350     ____ 25 user concurrent 1250
    ____ 25 user site 825

    ____ Extra manuals 5
    ____ Manual on disk (MS Word) 10
    ____ Manual on disk (TIFF) 15

    Candian shipping$        2
    Foreign Shipping         5
    NC Sales Tax ______ (NC residents only)

    Total: __________

    Payment:  Check or Money Order
 Visa
 Mastercard

|__|__|__|__|      |__|__|__|__|      |__|__|__|__|      |__|__|__|__| |__|__| |__|__|
Authorized Card Holder Number month year

    Expiration Date

_________________________________________ ______________
Authorized Cardholder Signature Date

Please remit to:
Cerious Software
1515 Mockingbird Lane, Suite 803
Charlotte, NC 28209 USA



You may also fax credit card orders to 704-529-0497.



.INI and .TUO File Settings

The following tables list the global and database-specific paramaters, and indicate the menu or 
dialog box from which the parameter can be changed:

Global Parameters (THUMBS.INI)

Section Parameter Menu/Dialog box Description
[Registration] UserName File>Register Your user name; entered when you register 

ThumbsPlus

UserCode Your user code; assigned when you register 
ThumbsPlus.

[Startup] WindowLeft,
WindowTop,
WindowWidth,
WindowHeight

Options
>Save for Startup
>Window Position

These parameters store the initial position and 
size of the ThumbsPlus main window for 
startup.

ThumbnailFile Options
>Save for Startup
>Initial Database

Path and file specification of the initial 
database for ThumbsPlus to load when 
starting. This may be overridden by specifying 
a database on the Command Line for the 
ThumbsPlus icon.

No3dControls (none) When non-zero, disables 3-D controls and 
dialog box appearance.

[Confirmations] FileDeletions Options>Confirmations When non-zero, requests you to confirm 
deletion of any file.

FileCopies Requests for confirmation for copying files.

FileMoves Requests for confirmation for moving files.

Directory... (Not yet implemented)

CloseModified
Window

Requests confirmation when closing a view 
window that has changed (been edited).

CloseApplication Asks "Are you sure you wish to exit 
ThumbsPlus" when you close the main 
window.

FileOverwrite Requests confirmation before overwriting a file
with the same name (copy or move).

[KnownFilters] Options
>File Types
>Configure
>Hunt for Filters

This sections contains a list of the graphic 
import filters which have been located using 
the Filter Hunt dialog box.

[JpegLoading] QuantizeColors Options>Jpeg Loading Selects whether the JPEG library reduces the 
color depth during the load of an image.

TwoPassQuant When quantizing colors, selects whether a 
two-pass quantization is selected.

Grayscale Discards color information and loads JPEG 
images in grayscale.

Dither Selects whether dithering is performed when 
reducing the color of a JPEG image on load.

QuantColors The number of colors to reduce to, when 
QuantizeColors=1.

[Batch] Format File
>Batch Edit/Convert

File format (i.e., BMP) in which to store batch 
converted files.

AutoCrop Autocrop images during the batch conversion.



Resize Rotate or resize during the batch conversion.

ColorAdjust Images are color adjusted during the batch 
conversion.

Depth Specifies whether the color depth is adjusted.

Overwrite Overwrite files with the same name.

AltExtension Specifies an alternate file extension for output 
files.

OutputPath Specifies the directory where converted files 
are placed.

[AutoPaste] Prefix Edit>Auto Clip Save Indicates the prefix for file names that are 
saved.

Sequence Next sequence number to use for Auto 
Clipboard Save.

Format File format for files saved from Auto Clipboard 
Save.

ConvertMetafiles Specifies whether metafiles are converted to 
bitmaps.

OutputPath Location to store Auto Clipboard Save'd files.

[Directories] SaveAs View>File>Save As Destination directory for Save As... dialog bo.

Copy Files File>Copy Destination directory for copying files.

Move Files File>Move Destination directory for moving files

Local (Database Specific) Parameters (THUMBS.TUO)

Section Parameter Menu/Dialog box Description
[Startup] InitialDirectory Options>Save Startup

Directory
Initial open directory in the directory list.

[FileTypes] SelectedTypes Options>File Types List of file types which are selected in the File 
Types dialog box.

[Options] AutoCropClipboard Options>General Set to one (1) to automatically crop images 
when copied to the clipboard.

AutoCropThumbnail Set to automatically crop images when making
thumbnails

AutoCropView Set to automatically crop images when 
viewing.

MinimizeOnCopy Set to automatically minimize the ThumbsPlus 
window whenever an image is copied to the 
clipboard.

MinimizeOnView Set to automatically minimize ThumbsPlus 
whenever an image is viewed.

MinimizeOnEdit Set to minimize ThumbsPlus whenever an 
image is passed to an external editor.

AutoRemoveOrphans Set to automatically remove orphans when 
changing to a new directory.

DefaultAction Specifies the default action to perform when 
double-clicking an image.

FontName The name of the font for the file and directory 
lists.

FontStyle The style of the file and directory list font.

FontSize The size of the file and directory list font.

FontItalic Non-zero to speficy an italic font.



FontWeight Weight of the font (400 = normal).

[FileList] Order Options>File List Specifies the order in which files are listed.

ShowFlags Coded value for what to show for each file.

UseMask Whether or not to use a file mask rather than 
the list of selected types from the Options>File 
Types dialog box.

Mask The file name mask to use for the file list.

ThumbnailSize The size of thumbnails, in percent (100, 150, 
200).

ShowFontNames Whether to show font names rather than the 
file names for Truetype fonts.

[Menu] IndicateExpandable
Branches

Tree>Indicate
Expandable

Show expandable (or collapsible) directories 
with a "+" (or "-").

IndicateBranchesWith
Thumbnails

Tree>Indicate
Thumbnails

Show directory branches with thumbnails by 
color-coding.

ShowThumbnail
BranchesOnly

Tree>Show Thumb
Dirs Only

Only show directory branches with thumbnails.

ShowOfflineVolumes Tree>Show Offline
Volumes

Include off-line (i.e., diskette and CDROM) 
volumes in the directory list.

StatusLine Options>Status Line Hide (0) or display (1) the status line.

Toolbar Options>Toolbar Hide (0) or display (1) the toolbar.

DirectoryListWidth (none) Specifies the last set directory list width (using 
the vertical spacer between the directory and 
file lists).

[Catalog] FontName File>Print    Setup
>Catalog Setup

Name of the font for catalog printing.

FontSize Size of the font (points) for catalog printing.

FontStyle Font style for printing.

FontItalic Indicates italic font.

FontWeight Font weight for printing.

LeftMargin,
RightMargin,
TopMargin,
BottomMargin

Margins for catalog printing (in units defined 
from International Control Panel settings).

PrintFileNames Print file names below thumbnails in catalog 
(0,1).

CatalogTitle Title to print at top of catalog.

LineSpacing Spacing between lines

ThumbnailSize Scaled size of thumbnails (100-1000 percent)

Columns Number of columns of thumbnails

[PageSetup] LeftMargin,
RightMargin,
TopMargin,
BottomMargin

File>Print    Setup
>Page Setup

Margins for image printing (in units defined 
from International Control Panel settings).

StretchToFit Stretch images to fit page (within margins).

MaintainAspectRatio Maintain aspect ratio when stretching images.

DrawBorder Draw a border around the image.

[SlideShow] BackgroundColor File>Slide Show Color index for background color for slide 
show.

DelaySeconds Number of seconds to delay between "slides."



ManualControl Set to advance slides with left mouse or 
keystroke.

StretchToScreen Stretch images to fit screen.

MaintainAspectRatio Maintain height:width aspect ratio when 
stretching.

HideCursor Hide the mouse cursor

ConvertMetafilesTo
Bitmaps

Convert metafiles (vector graphics) to bitmaps 
before displaying.

SkipSmallFiles Skip any files smaller than the specified size.

SmallFileWidth,
SmallFileHeight

Minimim size of files to display in slide show

RandomOrder Set to process files in random order (shuffled).

[Viewer] StretchImageToFit File>View Stretch images to fit window when window is 
resized.

FitPageWidth Stretch image to fit the width of the window 
(vertical scroll only).

MaintainAspectRatio Maintain the proper aspect ratio when 
stretching images or metafiles.

DitherMetafiles Use quick (unoptimized) display for metafiles.

InitialSize Coded value for the initial window size.

BackgroundColor
Index

Color index of background color.

MaxViewWindows Maximum number of view windows that may 
be simultaneously opened (2-40).

AutoDisplay
Comments

Automatically bring up a comment display 
window when viewing any image that has 
internal comments.

[Comments] FontName View>View
>Comments

Font name for comment display window.

FontSize Font size for comment window.

FontStyle Font style.

FontItalic Specifies an italic font.

FontWeight Font weight (400=normal)




